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Introduction 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=4 

This Open Educational Resource is for the beginning level of both interior design and architecture students who learn 

computer graphic communication software. 

The author created and developed a total of 22 tutorials to teach three computer graphic applications, AutoCAD, Revit, and 

Enscape. AutoCAD is an essential computer drafting software which is 2D drawing software. Revit is a Building Information 

Modeling software, which is 3D based modeling software. Lastly, Enscape is a real-time rendering and virtual reality plug-in 

for users’ 4D experiences. These three applications are the primary programs that design students should utilize for his/her 

design projects throughout an individual’s academic life in the College of Design and the student’s future jobs. 

Many design students rely on the instructor’s demonstrations during lectures for acquiring technical knowledge. 

Additionally, design students have tutorials from multiple resources such as textbooks and videos from that internet that 

are informed by the instructors or the students’ own search results. Typically, a textbook deals with only an application. 

And videos from the internet include unnecessary information like commercial advertisements. These separated sources 

of information often cause a student’s confusion and frustration. For these reasons, the book provides a unified format of 

tutorials to cover the three applications. The tutorials consist of both text and image-based tutorials as the primary resource 

and video-based tutorials as the supplemental materials. 

An instructor will demonstrate using the text and image-based tutorials, and share the link for the video-based tutorials after 

the lectures for student’s practice. This book provides two learning experiences. One is to create an architectural model by 

following the instructions provided in this book. The second is to create your own model by referencing the information 

from this book. 

Students learning outcomes 

The tutorials in this book may have positive impacts on students’ learning by 1) providing unified lecture contents to learn 

the main three graphic communication applications for design students, 2) offering free and readily available materials, 3) 

supporting two different formats of tutorials for different types of learner. 

Affordability of the teaching contents 

This bool help students’ finance because the materials are free with Creative Common. Whenever students need, the 

tutorials will be available without paying for the textbook. Currently, the course uses a textbook for only one application, 

Revit. It is because of the price of the textbook, and also the amount of information that the course covers. If the course relay 

on textbooks, students in the course should purchase two books, one for AutoCAD and the other for Revit, a textbook for 

Enscape is not published yet. 

Pedagogical strategies 

The author is developing hybrid tutorials to support diverse student’s learning styles. Some students tend to learn lecture 

contents through readings, some students learn lecture contents more effectively with video and audio, and some students 
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learn lecture contents with in-person coaches. The book implements two types of tutorials to cover visual learners and 

auditory learners. The tutorials also can be used for new instructors to teach similar lecture contents in the future. The 

instructors can investigate their time to prepare to deliver the lecture contents rather than to create the lecture contents. 
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PART ONE. AUTOCAD 

Chapter 1. Introduction of AutoCAD Chapter 1. Introduction of AutoCAD 

• What is the application & 4 different AutoCAD 

• How to install the application 

• Understand AutoCAD interface – Ribbon, Panels, Model space, Layout tabs, Status bar, & Properties 

• AutoCAD setup tips – Options, Unites, Workspace 

• Types and structure of drawings  in Auto CAD– Floor plan, RCP, Elevation, Section, & Details 

• Input commands and understand different selections 

• Understand basic drawing tools– Origin, Line, Move, Rotate, Copy 

• Attach image/PDF/CAD and Adjust the scale 

• Set the project folder, Save the file, and backups 

Chapter 2. Chapter 2. Draw Floor Plans Draw Floor Plans 

• Understand Layers – Name, Line type, Thickness, & Color 

• Draw centerlines – Line, Ortho, & Offest 

• Draw exterior/interior walls, floor, millwork & openings – Polyline, Spline, Circle, Rectecgul, Object Snap, Mirror, Fillet, 

Trim, Extend, Array, & Match Properties 

Chapter 3. Chapter 3. Create Dimensions and Components Create Dimensions and Components 

• Add/Edit dimensions (in model space)– Dim, & Dimension style 

• Add/Edit blocks from AutoCAD Tool Palette & Other sources – Door, Window, Column, Plumbing, Furniture & 

Equipment 

• Create custom blocks – Custom furniture 

Chapter 4. Chapter 4. Draw Elevations and Sections Draw Elevations and Sections 

• Draw a section 

• Draw an elevation from Floor plan 

• Add/Edit Text & Annotation (in model space) – MText, Text style, M leader, & Multileader Style 
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Chapter 5. Chapter 5. Draw Ceiling Plans Draw Ceiling Plans 

• Draw Ceiling Plans from Floor plan 

• Add/Edit Hatch 

• Create Legends 

Chapter 6. Chapter 6. Set Sheets Set Sheets 

• Understand the Model space and Paper spaces 

• Set a new layout – Page layout, & Plot styles 

• Set views in Paper spaces – Defpoints, Scaling 

• Add/Edit/Draw a titleblock 

Chapter 7. Chapter 7. Symbols and prints Symbols and prints 

• Add/Edit symbols in Paper spaces – drawing title, elevation symbol and section letters, north arrow 

• Printing 
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Chapter 1. Introduction of AutoCAD 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Understand what is the application & 4 different AutoCAD 

(CO 2) Install the application on your computer 

(CO 3) Understand the User Interface of AutoCAD – Ribbon, Panels, Model space, Layout tabs, Status bar, & Properties 

(CO 4) Understand AutoCAD setup tips – Options, Units, Workspace 

(CO 5) Understand the types and structure of drawings in Auto CAD- Floor plan, RCP, Elevation, Section, & Details 

(CO 6) Input commands and understand different selections 

(CO 7) Understand basic drawing tools- Origin, Rectangle 

(CO 8) Attach image/PDF/CAD and adjust the scale 

(CO 9) Set the project folder, Save the file, and backups 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO1) Understand what is the application & 4 different AutoCAD (CO1) Understand what is the application & 4 different AutoCAD 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

About CAD 

Computer-Aided Design(CAD) or Computer-Aided Design and Drafting (CADD) can be defined as using computer systems 

to assist in the creation, modification, analysis, or optimization of a design. (Narayan, 2008) 

CAD software is used to increase the productivity of the designer, improve the quality of design, improve communications 

through documentation, and create a database for manufacturing. (Narayan, 2008) 

image credit: Shaan Hurley, AutoCAD R14 Welcome Sample DWG, Flicker 

 

AutoCAD Session 1  |  6

https://iastate.pressbooks.pub/visualgraphiccomm/?p=5#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=5#pb-interactive-content


CAD is an important industrial art extensively used in many applications, including automotive, shipbuilding, and aerospace 

industries, industrial and architectural design, prosthetics, and many more. (Pottmann, and et al., 2007) 

About AutoCAD 

AutoCAD is an industry-leading commercial CAD software. 

AutoCAD is used by AEC(Architecture, Engineer, and Construction) to generate and optimize 2D and 3D designs. AutoCAD 

is a widely used software program that can help you draft construction documentation, explore design ideas, visualize 

concepts through photorealistic renderings, and simulate how a design performs in the real world. (Autodesk) 

AutoCAD was first released in December 1982 as a desktop app. In 2010, AutoCAD was released as a mobile- and web app, 

marketed as AutoCAD 360. (Autodesk and AutoCAD) 

Four AutoCAD products for AEC 

• AutoCAD: the original version of AutoCAD. This version can use architects, project managers, engineers, graphic 

designers, city planners, and other professionals. 

• AutoCAD Architecture: a version of Autodesk’s flagship product, AutoCAD, with tools and functions specially suited 

to architecture work. This software supports dynamic elements (wall, door, windows, and other architectural 

elements) and automatically updating Spaces and Areas for calculations of sqft. 

• AutoCAD LT:  the lower-cost version of AutoCAD, with reduced capabilities (No 3D, No Network Licensing, No 

management tools, and more). 

• AutoCAD 360: an account-based mobile and web application enabling registered users to view, edit, and share 

AutoCAD files via a mobile device and web using a limited AutoCAD feature set and using cloud-stored drawing files. 

(CO2) How to install the application (CO2) How to install the application 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

Install AutoCAD 

This version is for educational purposes only. 

You must know your system requirement first before you install the application. If you do not know your system use, please 

find the information here. 

• [STEP 01] Go to https://www.autodesk.com/education/free-software/autocad on your Windows side, open a web 

browser (Chrome is recommended because the instructor tested). 

• [STEP 02] Click [CREATE ACCOUNT] if you do not have one. If you already have an Autodesk account, please sign in 

by clicking [SIGN IN]. 
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• [STEP 03] Select an appropriate version of AutoCAD, your system, and language. 

• [STEP 04] Click [INSTALL]. 

• [STEP 05] Accept the license and services agreement. 

• [STEP 06] You will receive an email from Autodesk for the license information (Product key and Serial Number). It 

will be needed for the activation process. 

• [STEP 07] Click the downloaded installation file to install. The installation will take a while. 

• [STEP 08] After installation, the software will require activation. Please use the license information. 

(CO3) Understand AutoCAD interface – Ribbon, Panels, Model space, Layout (CO3) Understand AutoCAD interface – Ribbon, Panels, Model space, Layout 
tabs, Status bar, & Properties tabs, Status bar, & Properties 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

Once you open AutoCAD by double-clicking the AutoCAD icon, you can create a new drawing by clicking the [START 

DRAWING] icon on the first page of the AutoCAD application. 

You also can select a different template by clicking [TEMPLATES] under start drawing. The default setting is [acad.dwt] 

Your recent documents will show in the middle of the first page. You also can click to open the recent documents. 
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For the tutorial provided by Autodesk, you can click [LEARN]. I recommend you watch the Getting Started Videos. 

Once you click [START DRAWING], you will see this user interface below. [please remember the names] 

• Application menu: New, open, save, import, export, print 

• Quick access toolbar: User can save tools that they often use 

• Info Center: Ask a question, find out answers from Autodesk community 

• Ribbon: Main menus – Home, Insert, Annotate, View, Manage 

• Ribbon tab 

• Ribbon view: User can minimize and maximize the ribbon 
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• File tab: Navigate files and create and open files 

• Drawing area/graphic area: Main drawing space 

• View cube: User can change the view, top, front, 3D, or more 

• Navigation bar: Zoom in and out, pan, zoon to all, and more 

• Command box: Can type commands and see the previous commands 

• Layout tab: Can see model space and print spaces 

• Status bar: Can set grid, snaps, scales, and more 

Please see this detailed user interface that is provided by Autodesk 

(CO4) AutoCAD setup tips – Options, Unites, Workspace (CO4) AutoCAD setup tips – Options, Unites, Workspace 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

Before you start your drafting, it is recommended to set your workspace and options as you wish.  Take some time and 

experiment with the settings, as shown below. You can change settings at any time. 

Below are the instructor’s recommended setups based on more than 10-years of drafting experience. 

OPTIONS 

• [STEP 01] Click [APPLICATION MENU] and then Click [OPTIONS], or type [options] on the command box, and 

Enter key 

• [STEP 02] You will see the Option window 

• [STEP 03] Click Display tab > Change Color theme from dark to light 

• [STEP 04] Find Crosshair size on the Display tab > Change the value from 5 to 100 
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• [STEP 05] Find [Colors] and change Uniform background to Black> Click [Apply & Close] 
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• [STEP 06] Click the Draftingtab > Change the aperture size – make slightly smaller 

• [STEP 07] Click the Selection tab and uncheck[allow the press and drag for lasso] > Click [OK] to close the option 
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UNITS 

• [STEP 01] Click [APPLICATION MENU] > click [DRAWING UNITS] > click [UNITS] or, Type [units] on the 

command box > Enter key 

• [STEP 02] Confirm the units are right for your project 
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Below snap is an image of a typical setting for the Imperial system. 
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Below snap is an image of a typical setting for the Metric system. 

PROPERTIES 

• [STEP 01] Click the small arrow under Properties on Home Ribbon to open the Properties panel 

• [STEP 02] Or press [Ctrl+1] on your keyboard to open the Properties panel 

• [STEP 03] Place the panel on your left side of the workspace 

• [STEP 04] Click [Layer Properties] on Home Ribbon to open Layer properties 

• [STEP 05] Place the panel on your left side of the workspace and click the arrow to hide the panel 
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The interface after setting changes 

(CO5) Types and structure of drawings in Auto CAD- Floor plan, RCP, (CO5) Types and structure of drawings in Auto CAD- Floor plan, RCP, 
Elevation, Section, & DetailsElevation, Section, & Details  

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

Architects and Designers use AutoCAD in slightly different ways. It is different from firm to firm and depending on who 

draws the drawing. Moreover, it depends on what phase of the design you are in. 

Many design firms never use layout tabs. Some firms use AutoCAD only for Schematic Design purposes. Some designers use 

this application for presentation purposes too. 

However, in this course, we are targeting to use all essential functions to generate a Construction Document set. 

Below is a typical – fundamental – Construction Document set for an interior design project 

• Cover sheet + general project information 

• Floor plans 

• Furniture + Finish plans 

• Ceiling plans 

• Elevations + Sections 

• Details 

For detailed information about the types of drawings, please refer 
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Kilmer, W. Otie, and Kilmer, Rosemary. Construction Drawings and Details / W. Otie Kilmer and Rosemary Kilmer. Third 

ed. 2016. Print. 

(CO6) Input commands and understand different selections(CO6) Input commands and understand different selections  

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

To draw in AutoCAD, you must understand different types of command input 

• Use icons on Ribbon (Basic level) 

e.g. Click [Home] ribbon > Click [Text] 

• Use the commands box (Moderate level) 

e.g. Click [command box] > Type MULTILINETEXT > Enter key 

• Use Shortcuts (Advanced level) – Please practice to improve the speed of work and productivity. 

e.g., Type [MT] on a keyboard (mouse can be located anywhere, it can be lower case) > Enter 

Often use shortcuts by the instructor [please remember the list of shortcuts] 

• [l] – line 

• [pl] – polyline 

• [mt] – multiline text 

• [m] – move 

• [co] – copy 

• [ro] – rotate 

• [z] – zoom and [a] – all 

• [b] – block 

• [s] – stretch 

• [x] – explode 

• [ex] – extend 

• [c] – circle 

• [re] – regen (refresh) 

• [h] – hatch 

• [o] – offset 

• F3 – osnap 

• F8 – ortho 

Detailed information can be found in this link https://www.autodesk.com/shortcuts/autocad 

Three types of selections 

one click – individual objects 

• window selection (blue) – drag/click from left-top to right bottom to select all objects that are enclosed in the selection 
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rectangle.

• cross selection (green) – drag/click from right bottom to left to select all objects crossed by the selection rectangle.

Tip. To select multiple objects, just click one and another. No need to hold [shift] key or [ctrl] 

Refer to this link for select object Information from this link 
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(CO7) Understand essential drawing tools- Origin and Rectangle (CO7) Understand essential drawing tools- Origin and Rectangle 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

Understand the “origin” of the drawing 

AutoCAD drawing area is on a real scale, which means the drawing scale is 1:1 scale. Moreover, the drawing area is 

unlimited. You can draw the entire earth in the drawing. Furthermore, you can draw a small object, too. Designers often lose 

the point/location that they want to draw in the drawing when you draw in a big drawing. Thus, designers use the drawing 

origin (0,0,0) – ((x,y,z) for a 3D model) as the base point of the project. Usually, the origin of the drawing is the left-bottom 

corner on the first floor (if it is a 3D model). In AutoCAD, we use only (0,0) – (x,y). 

To start your drawing, draw a building footprint or property line first. 

• [STEP 1] Click [Rectangle] on the Home Ribbon, or type [rec] and Enter 

• [STEP 2] Specify the first point, type [0,0] and Enter 

• [STEP 3] Specify the next point. Any point on the right-top corner will be fine. It depends on the project size. For our 

project, type [58’7″,20’4″] 

• [STEP 4] Type [z] to zoom and type [a] and Enter

Line (command) 

• [STEP 1] type [l] and Enter 

• [STEP 2] specify the first point by clicking a point or typing [x,y] 

• [STEP 3] specify the end point by clicking a point or typing [x,y] – absolute point, type [@x,y] – relative point 
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• Please refer to this link for the line command 

Move (command) 

• [STEP 1] type [m] and Enter 

• [STEP 2] select the object/objects that you want to move and Enter 

• [STEP 3] specify the base point 

• [STEP 4] specify the second point to move the object/objects 

• Please refer to this link for the move command 

Copy (command) 

• [STEP 1] type [co] and Enter 

• [STEP 2] select the object/objects that you want to copy and Enter 

• [STEP 3] specify the base point 

• [STEP 4] specify the second point to copy the object/objects 

• [STEP 5] specify the third point or more to copy the object/objects if you have. If you want to stop, use ESC 

• Please refer to this link for the copy command 

• Please practice Line, Move, Copy, and Rotate commands 

(CO8) Attach image/PDF/CAD and adjust the scale of the attached file (CO8) Attach image/PDF/CAD and adjust the scale of the attached file 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

Download a floor plan image (Eames House-House) 

From this page, click [Eames_House_Floor_Plan_House.jpg] and mouse right-click to save the image file to your project 

folder. 

Your CAD file and JPG file MUST be in the same folder. Otherwise, you have to relink the file every time or set your link 

relatively. 

Insert the image file. 

• [STEP 1] Click [Insert] on the ribbon tab 

• [STEP 2] Click [Attach] on the Reference palette 
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• [STEP 3] Select [Eames_House_Floor_Plan_House.jpg] from your project folder > Click  [open] 

• [STEP 4] Click [OK] on the Attach Image window 

• [STEP 5] Click the origin point or type [0,0] and Enter 

Adjust scale 

• [STEP 1] Specify the scale factor [1] and Enter 

• [STEP 2] Select the inserted image > Change the Fade value to [50] or lower that you can see the background 
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• [STEP 3] Zoom in to the scale or a known dimension 

• [STEP 4] Type [SC] and Enter for Scale change 

• [STEP 5] Click a base point > Type [r] and Enter > Click the base point > Click a second point that you know a 

dimension (for this draw, you can use the scale bar) > Type the known dimension [1′]

Change the drawing order 

• [STEP 1] Click the inserted image 
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• [STEP 2] Mouse right-click > Click [Draw Order] > Click [Send to Back] 

Move the image to the building footprint 

• [STEP 1] Select the inserted image 

• [STEP 2] Type [m] to move and Enter 

• [STEP 3] Click a base point > Click the target point to move 

• Tip! Use Object snap [F3] to select the target point from the building footprint.
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(CO9) Set the project folder, Save the file, and backups (CO9) Set the project folder, Save the file, and backups 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=5 

Save the file 

It is vital to save your file as early as possible. Moreover, save anytime, and the moment you think it is appropriate. I usually 

save within 15 min (at least four times per hour). 

• [STEP 01] Click [Application menu] > Click [Save] 

• [STEP 02] Select a project folder on your hard drive, external hard drive, USB, Dropbox, or Onedrive 

• [STEP 03] Recommended file type – AutoCAD 2007/LT2007 Drawing(*.dwg) 

• [STEP 04] Recommended file name – Eames_House_Project_Firstname_Lastname_01.dwg 

Tip! (.bak) file is a backup file. In the default setting, every 10 minutes, the file will be saved. To use the backup file, change 

the file extension (.bak) to (.dwg) 
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Chapter 2. Draw floor plans 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Understand Layers – Name, Line type, Thickness, & Color 

(CO 2) Draw centerlines – Object snap, Line, Move, & Offest 

(CO 3) Draw exterior/interior walls, floor, millwork & openings – Polyline, Spline, Circle, Rectengule, Object Snap, Mirror, 

Fillet, Trim, Extend, Array, & Match Properties 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Understand Layers –(CO 1) Understand Layers –  Name, Line type, Thickness, & Color Name, Line type, Thickness, & Color 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=32 

The concept of layers in CAD 

Architects and designers use layers in vector-based CAD software. 

The concept of layers allows CAD information to be organized, facilitates the visual display of the information on a 

computer screen, and allows the information to be efficiently converted to the conventional print media of drawings. 

The efficient use of layers can reduce document preparation time and improve document coordination. 

The American Institute of Architects and National Cad Standard published “AIA CAD Layer Guidelines.” 

Using layers can make your drawings easier to control and interpret for both you and your team. For example, you can draw 

your interior walls on one layer, and furniture on another using a different color. You can quickly turn off your furniture 

layer on a floor plan and turn on the furniture layer on a furniture plan. 

You can control layers from the Layer Property Manager. 

Each layer has a set of properties assigned to it. 

• Name 

• Turn On/Off 

• Freeze – Looks the same as turning on and off but uses less memory. Boost the speed of work. 

• Lock 

• Plot – It shows on your screen, but it will not print. 

• Color – It is for working on the screen – easier to recognize the layers by color. Usually, prints in black and white. 

• Line weight – Important to identify the hierarchy of the lines 

• Line type 

• Transparency – not often used 
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• Description – note for the layer 

Create Layers for the project 

• [STEP 01] Open the Layer Property Manager panel by clicking the [Layer Property] icon under the [Home] tab on the 

[Layers] panel. 

• [STEP 02] Click [New Layer] or Press [Alt+N] to add a new layer 

• [STEP 03] Rename the name of the layer by double-clicking the name of the layer to A-WALL 

• [STEP 04] Update the color of the layer by clicking the color section to YELLOW 

• [STEP 05] Update the line weight of the layer by clicking the Lineweight section to 0.5 

• [STEP 06] Repeat the [STEP 02] to [STEP 05] to create the listed Layers below. 

Note 1. To update line type, click the line type that you want to update, and click [LOAD], and find the line type that you 

want to use for a layer, and click [OK], click the loaded line type to apply, and click [OK] to apply. 

Note 1A. Due to the scale issue, the line type will not show it correctly. To correct the line type scale, type [lts] on the 

keyboard, and press the [Enter] key and enter [number]. For this project, try [10] 
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Note 2. The name of the layer is based on AIA CAD layer guidelines, the instructor modified. If you need other layers, please 

refer to the guideline. 

Apply a layer to a model 

[Method 1] 

• [STEP 01] Fine a line/lines or an element/elements that you want to apply a layer 

• [STEP 02] Select a layer that you want to apply to, then a layer of the element will be changed 

[Method 2] 

• [STEP 01] Select a layer that you want to draw 

• [STEP 02] Draw a line/lines or an element/elements within the layer 

[Method 3] 

• Use [MATCHPROP] command or [MA] – match the property to copy a layer style to another 

Tip. I prefer to use this method to speed up the work – Draw lines with all layers with name on the side of the drawing, 

and use match property command whenever it is needed. You can save time to find the layer and select the layer from the 
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drop-down menu. 

(CO 2) Draw centerlines-column grid – Object snap, Line, Move, & Offset (CO 2) Draw centerlines-column grid – Object snap, Line, Move, & Offset 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=32 

Drawing a centerline can be the first step in drawing a floor plan. The drawing order depends on the phase of design and 

who is drawing. However, setting centerlines can be easier to draw a floor plan rather than starting from scratch. 

• [STEP 01] Select the right layer to draw column grids. Click [S-GRID] from the [Home] ribbon on the [Layers] tab 

• [STEP 02] Make sure [othormode] and [osnap] is on 

OSNAP setting – to select a specific point of an element, it is recommended to use object snap [OSNAP]. To set up object 

snap, mouse right click on the OSNAP icon on the Status bar and check the point that you would like to select while the 
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object snap is on. 

This image is the recommended object snap settings for 2D drafting, based on the instructor’s experience. Note. For more 

information regarding OSNAP, please read this link about using Object Snapes. 

• [STEP 03] Select [Line] from [Home] ribbon on [Draw] tab ,or Type [l] and press [Enter] on the keyboard to draw lines 

Click the base point [0,0] and mouse move to plan north, and type [25′] and press [Enter] on the keyboard 

• [STEP 04] Move the gridline to the center of the building base footprint. 

Click [Move] icon  from [Home] ribbon on [Draw] tab 

or, type [m] and press [Enter] key 
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Click the midpoint of the selected line, and then click the midpoint of the building footprint 

• [STEP 05] To create vertical grid lines, it is recommended to use the [OFFSET] command. 

Click [OFFSET] icon  from [HOME] ribbon on [DRAW] tab 

or, type [o] and press [Enter] key 

Type a specific number that you want to offset, for this project, enter 7′-4-3/4″ 

and then press [Enter] key, 

and then click a point to the direction that you want to create the copied line, 

if you use the same distance, you do not need to enter the number, 

if you use a different distance, you must enter a specific number 

• [STEP 06] Repeat [STEP 03] to [STEP 05] for horizontal grid lines 

• [STEP 07] Copy the first level grid lines, both vertical and horizontal, for the second level 

To copy the lines, please use an even number (e.g., 28′-11″ based on the base drawing) 
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(CO 3)(CO 3)  Draw exterior/interior walls, floor, millwork & openings –Draw exterior/interior walls, floor, millwork & openings –  Polyline, Polyline, 
Spline, Circle,Spline, Circle,  Rectangle, Mirror, Fillet, Trim, Extend, Array, & Match Properties Rectangle, Mirror, Fillet, Trim, Extend, Array, & Match Properties 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=32 

Let’s draw the floor plans (no columns, no furniture, no windows, no doors, no patterns, no symbols, no plumbing, no 

dimensions, no texts at this point) with the following commands 
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image credit: Screen captured by the Author from the application 

Make sure you use the commands below to control and easy selection 

[ORTHO] or [F8] key, [OSNAP] or [F3] key 

If needed, you can turn on/off [grid] by press the [F7] key 

Polyline(command) – this is for creating a connected line. Once you make an element (wall) with a polyline, the lines will be 

connected. This connection is useful in controlling each element. 

• [STEP 01] Type [pl] on keyboard and press [Enter] key 

• [STEP 02] Specify start point 

• [STEP 03] Specify the next point. 

• [STEP 04-01] If you want to close the object, type [c] on the keyboard and press the [Enter] key 

• [STEP 04-02] If you want to finish the object without closing the object, press the [ESC] key 

• Please refer to this link for the polyline command 

Pedit(command) – this used to convert line objects to a polyline 

• [STEP 01] Type [pe] on keyboard and press [Enter] key 

• [STEP 02] Specify an object to convert a polyline 

• [STEP 03] Type [y] and press the [Enter] key to turn the objects into one object. 

• [STEP 04] Select [ Join] 

• [STEP 05] Select all connected objects that you want to join as a polyline, and press [Enter] key, and press [Enter] key 

one more time to finish the command 

• Please refer to this link for the Pedit command 

Explodes(command) – this is to convert a polyline or a block to line objects 

• [STEP 01] Select an object (polyline or a block) to convert to line objects 
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• [STEP 02] Type [x] on the keyboard, and press [Enter] on the keyboard 

• Please refer to this link for the Explodes command 

Spline(command) – may not be needed for the Eames House project, but you will need it for your project  – These 

commands for creating a connected curved line. 

• [STEP 01] Type [spl] on keyboard, and press [Enter] key 

• [STEP 02] Specify the first point 

• [STEP 03] Specify the next points 

• [STEP 04] Press [Enter] key to finish 

• Please refer to this link for the Spline command 

Circle(command) 

• [STEP 01] Type [c] on keyboard, and press [Enter] key 

• [STEP 02] Specify a center point 

• [STEP 03] Specify a radius by typing a specific number of by clicking a specific point 

• Please refer to this link for the circle command 

Rectangle(command) 

• [STEP 01] Type [rec] on keyboard, and press [Enter] key 

• [STEP 02] Specify a first corner point 

• [STEP 03] Specify another corner point 

• Please refer to this link for the Rectangle command 

Mirror(command) 

• [STEP 01] Type [mi] on keyboard, and press [Enter] key 

• [STEP 02] Select an object/objects, and press [Enter] key 

• [STEP 03] Specify the first point of the mirror line 

• [STEP 04] Specify the second point of the mirror line 

• [STEP 05] Decide whether to erase the source objects or not, and press the [Enter] key to complete the command 

• Please refer to this link for the Mirror command 

Fillet(command) – create a corner between two objects 

• [STEP 01] Type [f] on keyboard, and press [Enter] key 

• [STEP 02] Select the first object 

• [STEP 02-01] If you want to create a smooth corner, you can specify radius by type [r] and press [Enter] key, and type 

[specific number] and press [Enter] key 

the radius information will be stored, if you want to create a sharp corner, the R = ‘0.’ 

• [STEP 03] Select the second object 

• Please refer to this link for the Fillet command 

Trim(command) 

• [STEP 01] Type [tr] on keyboard, and press [Enter] key 

• [STEP 02] Select cutting edges 

AutoCAD Session 2  |  34

https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-Core/files/GUID-E98BCEF4-DED6-48A6-87EB-10FE87188083-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-Core/files/GUID-5E7D51E2-1595-4E0C-85F8-2D7CBD166A08-htm.html?v=2020&st=spline
https://knowledge.autodesk.com/support/autocad-lt/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-LT/files/GUID-C60B6D5D-AAEB-420F-917F-6E6B47E92F48-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-Core/files/GUID-188B2DDA-6CD8-4D37-BF26-E6CF27C34C75-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-Core/files/GUID-595277C8-9B87-4CFB-A3AF-769537A22F3D-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/AutoCAD-Core/files/GUID-64F8B700-23B3-4BD6-8C03-66121AA13E8F-htm.html


• [STEP 03] Select object(s) to trim, and press the [Enter] key to complete the command 

• Please refer to this link for the Trim command 

Extend(command) 

• [STEP 01] Type [ex] on keyboard, and press [Enter] key 

• [STEP 02] Select boundary object(s) 

• [STEP 03] Select object(s) to extend, and press the [Enter] key to complete the command 

• Please refer to this link for the Extend command 

Stretch(command) 

• [STEP 01] Type [s] on keyboard, and press [Enter] key 

• [STEP 02] Select objects – specify the portion of the object that you want to stretch, using the crossing object selection 

method, and press [Enter] key 

• [STEP 03] Specify the base point 

• [STEP 04] Specify the destination point to complete the command 

• Please refer to this link for the Stretch command 

Match Property(command) 

• [STEP 01] Select source object 

• [STEP 02] Select destination object(s) 

• Please refer to this link for the Match Property command 

There is no right or wrong way to draw a floor plan, be creative, Designers!! 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 3. Create dimensions and components 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Add/Edit dimensions (in model space) – Dim, & Dimension style 

(CO 2) Add/Edit blocks from AutoCAD Tool Palette & Other sources – Door, Window, Column, Plumbing, Furniture & 

Equipment 

(CO 3) Create custom blocks – Custom furniture 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Add/Edit dimensions (in model space) – Dim, & Dimension style (CO 1) Add/Edit dimensions (in model space) – Dim, & Dimension style 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=78 

Open your working CAD file. 

Understand CAD dimension scale settings 

• [METHOD 01] Dimension in model space for plotting in model space – This is the traditional method used with 

single-view drawings – Need Text height charts for correct text height, and it is challenging to be flexible in drawing 

scale. 

• [METHOD 02] Dimension in model space for printing or plotting in paper space – This was the preferred method for 

complex, multiple-view drawings. (We will practice this method for our project) 

• [METHOD 03] dimension in layouts – This is the simplest dimensioning method 

• Please refer to this link for more information about scale for dimensions 

Text Heights in paper space (1=1) 

• 10 pt = 3/32” (minimum font to read) 

• 12 pt = 1/8” (Standard text size) 

• 18 pt = 3/16” (Subtitle text size) 

• 24 pt = 1/4” (Title text size) 

Understand the types of dimensions 

• The basic types of dimensioning are linear, radial, angular, ordinate, and arc length. 

• Please refer to this link for more information about the types of dimensions 
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Before you add dimensions, move the inserted drawing image to avoid accidental deletes and confusion. 

Move the image to the right side – 100ft or any number that you can easily remember. You might need to move the image 

back to the original position. 

Note. Make sure you turn on [ortho] 

Set Drawing scale 

• Before you start to add dimensions, it is recommended to set the drawing scale. Sometimes, the drawing scale can be 

changed for the drawing. However, once you set the drawing scale, less work is needed at the end. 

• The drawing scale is defined with some factors – the paper size, purposes of submissions, and so on. 

• For this project, you will be asked to print out your drawings in 11in x 17in (Horizontal layout). Although the inserted 

original drawing scale is 3/8″ = 1′ -0″, your drawing scale should be 3/16″ = 1′ -0″ 

• To set the scale, click the drawing scale [1:1] and select the drawing scale [3/16″ = 1′ -0″] 

image credit: Screen captured and modified by the Author from the application 

• If you cannot find the ft-in types of scale, click [Custom] > click [Add] > add the name of the scale [3/16” = 1’-0”], add 

the value on Paper units [3/16], add the value on Drawing units [12] > click [OK] to complete the custom scale > click 

[OK] to set the scale 

Set Dimension style 

“A dimension style is a named collection of dimension settings that control the appearance of dimensions, such as arrowhead 

style, text location, and lateral tolerances.” (Autodesk help, Mar 29, 2020) 

Please refer to this link for more information about dimension style 

• [STEP 01] To open Dimension Style Manager, 

click [Annotation] ribbon tab, click [ ] on Dimension panel 

or, type [ddim] and press [Enter] key 

• [STEP 02] Click [Annotative] > Click [Set Current] > Click [Modify] to open Modify Dimension Style: Annotative 

window 
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• [STEP 03] Click [Lines] tab 

adjust the Baseline Spacing to 1/16″ 

adjust the Extend beyond dim lines to 1/16″ 

adjust the Offset from origin to 1/16″ 
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• [STEP 04] Click [Symbols and Arrows] tab 

adjust the first Arrowheads to / Architectural tick 

adjust the second Arrowheads to / Architectural tick 

adjust the arrow size to 1/8″ 

adjust the break size to 1/16″ 

adjust the Jog height factor to 1/16″ 
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• [STEP 05] Click [Text] tab 

adjust the text height to 1/8″ 

select Aligned with the dimension line 
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• [STEP 06] Click [Fit] tab 

make sure [Annotative] is checked 
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• [STEP 07] Click [Primary Units] 

adjust the Unit format to Architectural 

adjust the Precision to 0′ -0 1/8″ 
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• [STEP 08] Click [OK] to complete the modification > Click [Close] to finish the dimension style manager 

Add dimensions 

• [STEP 01] Change layer to [A-ANNO-DIMS] 

• [STEP 02] Click [Annotate] ribbon tab > make sure the dimension style is [Annotative] > click [Linear] to draw 

dimensions 

or, type [dim] and press [Enter] 

If Linear doesn’t fit for your purpose, please select the types of dimension that you want to add. 
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• [STEP 03] make sure you turn on Object Snap 

Click the intersection point at the top left corner of the building column grids 

Click the next intersection point for dimensioning 

Click a third time to place the dimension line and text 

• [STEP 04] if the dimensions are in a continuous string, please use [continue]  from the [Annotation] 

tab, [Dimensions] panel. 

Add additional dimension lines to the previous dimension. 

• [STEP 05] Repeat to dimension all column grids for the first floor and overall building dimensions. 
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Add a new dimension style 

– 3/32″ text size – Annotative and interior wall dimensions. 

• [STEP 01] Type [ddim], and press [Enter] key to open [Dimension Style Manager] 

• [STEP 02] Click [New] to create a new dimension style 

• [STEP 03] Add new style name [Annotative 3-32], check start with [Annotative], [Annotative] checked, and click 

[Continue] 

• [STEP 04] Adjust Arrow size from Symbols and Arrows to 1/8″, 

adjust Text height from Text to 3/32″ 

click [OK], click [Set Current] and click [Close] 

• [STEP 05] Make sure your layer is correct in [A-ANNO-DIMS] 

• [STEP 06] Type [dim], and press [Enter] key and start dimensioning for the interior walls (You don’t need to match 

your dimensions exactly, as reference for this project, +/- 4 inches are acceptable) 

(CO 2) Add/Edit blocks from AutoCAD Tool Palette & Other sources – Door, (CO 2) Add/Edit blocks from AutoCAD Tool Palette & Other sources – Door, 
Window, Column, Plumbing, Furniture & Equipment Window, Column, Plumbing, Furniture & Equipment 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=78 
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Understanding the concept of blocks in AutoCAD 

• A block is a collection of objects that are combined into a single named object. 

• Although a block and a group in AutoCAD look similar, these are different concepts. 

Basically, blocks are copies that will change if you change one, but groups will not change. Groups are unique. 

• A block consists of the name of the block, the block geometry, the location of the base point, and any associated 

attribute data. 

• For more information about blocks, please refer to this page 

Source of blocks 

Designers/drafters often bring blocks from outside resources. They use free resources from other websites and/or resources 

from the firm for schematic design to save time, resources from manufacturers for design development, and/or construction 

documents. 

AutoCAD provides some basic blocks. You can find the block from the [Content Browser] and add blocks to [Tool Palette] 

and [Design Center] 

Cad library websites 

• BIM object – https://www.bimobject.com/en-us 

• CAD blocks – https://cad-blocks.net/index.html 

• DWG models – https://dwgmodels.com/interiors/ 

Furniture manufactures websites for the Cad library 

• Knoll – https://www.knoll.com/design-plan/resources/furniture-symbols 

• HermanMiller – https://www.hermanmiller.com/resources/3d-models-and-planning-tools/product-models/ 

• Steelcase – https://www.steelcase.com/resources/3d-models-cad/ 

• AllSteel – https://cms.allsteeloffice.com/Pages/Design-Resources/Planning-Tools/PlanningToolsLandingPage.aspx 

If designers/drafters cannot find blocks that they want to use for the project, they can create custom blocks. Sometimes it 

saves more time. 

Add blocks from Tool Palettes (Use basic blocks from AutoCAD library) 

Move the linked Eames House Floor plan image to match the drawing for reference– We moved the image to 100ft to the 

right. At this time, move the image back to the original place. If the image is hidden, show the image by clicking [Show Image] 

on the Image ribbon. If the image hides your drawing (Cad objects), let’s change the drawing order by mouse right-click on 
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the image and click [Draw Order] > click [Send to Back] 

We will add columns from the tool palettes. 

• [STEP 01] Click [View] tab > Click [Tool Palettes] under Palettes panel to open the panel or, type [TOOLPALETTES] 

on the command, and press [Enter] key 

Once the tool palettes are open, place the palette in a comfortable location (I personally like all palettes on the left side 

of the application. 

• [STEP 02] Click [Structure] tab on the tool palettes > Click [WF beam – Imperial] 

• [STEP 03] Change the layer to [S-COLS] 

• [STEP 04] Place the column on the top-left corner of the building. At this time, you cannot place the [WF beam – 

imperial] to the precise location. 
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• [STEP 05] Move the column to the right position using [osnap] and guidelines 

• [STEP 06] Copy the column to other positions of the first-floor plan; you will need to rotate the drawing and adjust 

your drawing according to the column locations. 

Tips. Use the intersection with object snap [F3] and ortho tool [F8] 

• [STEP 07] Copy the columns on the first floor to the second floor. 
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You may lock the layers that do not need to be selected. After you copy the columns on the first floor to the second 

floor, you may also unlock the layer you locked. 

Edit a Dynamic block 

You can find [Door-Imperial] and [Window-Imperial] from the Architecture tab on the tool palettes to add to your drawing. 

However, the currently loaded blocks (ex. [Door-Imperial] and [Window-Imperial] with a thunderbolt image) on the tool 

palettes are called [Dynamic block], a dynamic block is a parametric block that users can easily modify. 

• [STEP 01] Click [Window – imperial] on the tool palette 

• [STEP 02] Place [Window – imperial] block in your drawing 

• [STEP 03] Double-click [Window – imperial] to open Edit Block Definition 

• [STEP 04] Click [OK] to open the Block Editor 
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• [STEP 05] Select [Width=3’-0”] and adjust [Dist type] to [Increment] on the properties palette. And adjust [Dist 

increment] to [1/4”] 

• [STEP 06] Select [Wall=0’-4”] and adjust [Dist type] to [Increment] on the properties palette 

• [STEP 07] Click [Save Block] from the [Block Editor] ribbon 

• [STEP 08] Click [Close Block Editor] to close 

• [STEP 09] Relocate the window and update the size of the window according to the floor plan 
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Repeat the steps for [Door-Imperial]. You will need to change the [Dist type] for [Door Size] and [Wall Thickness] 

Complete placing and adjusting windows (curtain walls) and door (interior and exterior doors) within correct layers. If you 

can find the blocks, you can draw the elements with [line] or [poly line] 

Add more blocks using [Design Center] 

Design Center is a tool to access and add blocks, Dimension styles, Layers, Layouts, Line types, Multi leaders, Table styles, 

Visual styles, and Xrefs. 

For more information about the Design Center, please refer to this page 

I am going to demonstrate how to load a sink from the AutoCAD sample blocks. 

• [STEP 01] Change layer to [P-FIXT] 

• [STEP 02] Click [View] tab > Click [Design Center] icon 

or, Type [adcenter] on the command line, and press [Enter] key to open the Design Center window 
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• [STEP 03] Once you click the [Home] icon , you can find [en-us] folder > double-click to open [en-us] > double-

click to open [Design Center]. You can find some sample drawings containing blocks 

The folder structure may be different from the versions of AutoCAD, but generally, you can find the sample CAD files 

C:\Program Files\Autodesk\AutoCAD 2020\Sample\en-us\DesignCenter 

• [STEP 04] Double-click [Kitchens.dwg] > Double-click [Blocks] > Double-click [Sink-single-30 in top] to inset in your 

file > Click [OK] to confirm the information 

• [STEP 05] Place the sink in the kitchen, using object snap 

• [STEP 6] Click the inserted block [Sink-single-30 in top] > Mouse right-click > Click [Edit Block In-place] > Click [OK] 

on reference Edit 

• [STEP 7] Use [Stretch] tool to resize the sink, and delete elements that are not needed, and add geometrics for the sink 

Note 1. For the assignment, you don’t need to make the model 100% the same. Some flexibility will be acceptable 

(shape of sink and faucet) 

Note 2. When you draw a new line and element, use the [0] layer in a block 

• [STEP 8] Once you are done with the editing > Click [Save Changes] on the [Home] ribbon, under [Edit Reference] 

panel 

AutoCAD Session 3  |  54



If you want to rename the block, type [rename] on the commend. > Click [blocks] > Click [blocks that you want to rename] 

If the block is your own or whether it was modified from another or created new, add [000_] in the first part of the block 

name to recognize/find the block easily 

If you want to use a downloaded CAD file (e.g., https://cad-blocks.net/kitchen-cad-blocks-kitchen-sink.html ). 

• Save the downloaded file in a project folder 

• Open the [design center] 

• Click [Load] 

• Find the project folder where you saved the downloaded cad file 

• Click [Open] to load 

• Double-click [Blocks] 

• Select a block that you want to use in your project and double click to load 

If the inserted block is the wrong scale, adjust the scale. 
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Please use these strategies to draw plumbing fixtures in the kitchen and bathrooms. 

You will select your selections of blocks. The below image is a reference only. 

• Add (2) beds in the bedrooms 

• Add (1) desk and chair set in the bedroom 

• Add (1) dining table-chair set in the dining area 

• Add (1) table in the alcove 

• Add (1) table in the living room 

• Add bookshelves in the living room 

• Add (1) lounge chair in the living room 

• Add (2) chairs in the living room 

We will ask you to create custom furniture (sofa set) below. 

(CO 3) Create custom blocks – Custom furniture (CO 3) Create custom blocks – Custom furniture 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=78 

Sometimes, you may experience difficulty finding CAD blocks from CAD library websites and/or manufacturers’ websites. 

Especially, it is hard to find furniture blocks for residential projects. In this tutorial, you will learn how to create blocks using 
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product information and photos. I will demonstrate it using two different sofa sizes from the website Design Within Reach 

(DWR). You will create using your selections of furniture for the project. 

Create an 86″ sofa block 

• [STEP 01] Retrieve the product information (dimensions) and images from the DWR website 

• [STEP 02] Change layer to [0] > Draw overall size of the sofa (Width=86” & Depth=33”) using [pline] or [rectang], make 

sure turn [ortho] on for 90 degree 

• [STEP 03] Download or screenshot the product image to your project folder 

Most of the time, you cannot find a top view of a product. You may rely on a front view to draw a floor plan view for 

the product. 

• [STEP 04] Insert the front view image into your drawing file. Click [Insert] tab > Click [Attach] > Click the downloaded 

file > Click [Open] > Click [OK] on Attach Image > Click once on the drawing area > Click once again near the first 

point > Click the inserted image > Adjust the [Fade] value to [50] > mouse right-click on the image > Click [Drawing 

Order] > Click [Send to back] 

• [STEP 05] Relocate and rescale the inserted image to match the overall sofa dimensions. 

For relocating, you will need to use [Move], [Rotate], and [osnap] command. 

For rescaling, you will need to use [scale] with Reference [R]. 

• [STEP 06] Draw the details of the sofa using [line], [pline], [rectang], and [circle]. Use the detailed dimensions what the 

website provided. Also verify the dimensions using [distance] – type [di] and press [Enter] key 

• [STEP 07] Before defining the lines to a block, make sure all lines are in the [0] layer. 

• [STEP 08] Select all lines for the sofa (excluding the inserted image) > Type [b] on the command line and press [Enter]. 

Block Definition window will open > Name the block something meaningful (e.g., 000_DWR-Bantam_Sofa-Plan) > 

Click [OK] > Change the block from [0] layer to [I-FURN] > If you don’t need the inserted image anymore, you can 

delete the image. 

Create a 73″ sofa block using the [000_DWR-Bantam_Sofa-Plan] block 

Rather than redraw the 73″ sofa block from scratch, you can start with the [000_DWR-Bantam_Sofa-Plan] block and using 

the Stretch tool to adjust the length. 

• [STEP 01] Type [co] to copy [000_DWR-Bantam_Sofa-Plan] block or Insert the [000_DWR-Bantam_Sofa-Plan] block 
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on the drawing area – Click [Insert] tab > Click [insert] icon under Block panel > Select the block > place the block on 

the drawing area. 

• [STEP 02] Type [x], and press [Enter] key. The Explode command breaks up a block into individual lines. This 

commend is useful to convert a block into elements for redefining a block. 

For more information about this command, refer to this page. 

• [STEP 03] Use [Stretch] commend to resize the sofa. And edit the details. 

• [STEP 04] Create a new block by typing [b], and pressing [Enter] > name the block [000_DWR-Bantam_Sofa-73-Front] 

> update the layer to [I-FURN] > place the sofa 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 4. Draw elevation and sections 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Draw a section 

(CO 2) Draw an elevation from the floor plan 

(CO 3) Add/Edit Text & Annotation (in model space-annotative) – M Text, Text Style, M leader, and Multileader Style 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Draw a section (CO 1) Draw a section 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=80 

“A section is a cut-through of a space that will show more of the room’s features. It also allows you to show some structural 

detail. A section line can be cut from any part of the space, depending on what you would like to show.” 

Retrieved from https://www.nda.ac.uk/blog/identify-plans-elevations-sections/ 

“A ‘section drawing,’ ‘section,’ or ‘sectional drawing’ shows a view of a structure as though it had been sliced in half or cut 

along another imaginary plane.” 

Retrieved from https://www.designingbuildings.co.uk/wiki/Section_drawing 

For more information about a building section drawing, please read this page: https://www.designingbuildings.co.uk/wiki/

Section_drawing 

In this tutorial, students will draw a building section based on Eames House, House, Section A-A’ drawing, the plan south 

section (You can download the image from Canvas Module and this link Eames_House_House_Section_A-A’.jpg), and your 

space planning (Furnishings, fixtures, and equipment). 

image credit: Screen captured by the Author from http://www.loc.gov/pictures/collection/hh/item/ca4169/ (Eames House 

as-built drawing, public domain) 

 

• [STEP 01] Open your CAD file for the Eames House Project. 

• [STEP 02] Copy the floor plans (1st floor & 2nd floor) to the right side 100′. This step is optional, but I prefer to save 

the original plans and to use the copied plans for creating a section view. 
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• [STEP 03] confirm you are in [0] layer and Draw a section line (recommended to use [PLINE]) on the first floor for a 

section view. Copy the section line in the same position for the second floor. You can rely on a column grid line. (For 

section line, you can break and offset the line to focus on key interior and/or architectural elements. The line should 

start and stop outside of the plan, and you should add a small perpendicular box to indicate the direction of the section 

view. Update the section lines to the [A-ANNO] layer. 

• [STEP 4] Draw a perpendicular line from the section line on the first floor to indicate the building boundary and 

drawing boundary. 

• [STEP 5] Insert the section drawing (Eames_House_House_Section_A-A’.jpg) by clicking [inset] > click [attach] > select 

the file Eames_House_House_Section_A-A’.jpg from your project folder > click [open] > click [ok] on Attach Image 

window > click a base point and the second point to insert the image > adjust Image Fade to 50 > mouse right-click on 

the image > click [Draw Order] > click [Send to Back] 

• [STEP 6] Relocate (use [move] command) and rescale (use [scale] command) the inserted image to fit the building 
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boundary for the section lines. 

Note, you must use the object snape [F3] appropriately when you adjust the scale. Sometimes the object snap works 

perfectly to click the CAD object. Sometimes the command does not work to click a point in a raster image. 

• [STEP 7] Now, you are ready to draw the section with the inserted image. 

◦ Note 1. You will rely on the dimensions on the inserted image, the lines on your floor plan. Use numeric values to 

draw lines (please, don’t just click on the image except for the spiral stair. The image is reference only because the 

scaled image is always a bit off). 

◦ Note 2. Create three new layers 

▪ [A-LWT-OBJECT] 0.2mm – The edges of objects, and represent a change in depth 

▪ [A-LWT-SECTION] 0.5mm – The lines are representing the boundary of anything cut-through 

▪ [A-LWT-SURFACE] 0.05mm – The lines are detail lines on an object. They don’t represent much (if any) 

change in depth 

◦ Note 3. Use [LINE]. [PLINE], [SPLINE], [CIRCLE], [TRIM], [OFFSET], [FILLET], [EXTEND], and [STRETCH] 

commands. 

◦ Note 4. You also update the line type manually for door and window openings. 

◦ Note 5. First, you draw the guidelines. You are using [xline] for creating a line of infinite length. 
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◦ Then, you draw the section lines. 

◦ After that, you draw the object lines. 

◦ Draw surface lines for details. 
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◦ Finally, you add furniture, and you should edit the details and objects hidden from the front of the object. 

• [STEP 8] Move the section and the section lines that you drew except the inserted image 100′ to the left to save the 

section drawing in a safe drawing area. 

• [STEP 9] Create a block for the section. Select all the elements in the section > Type [B] for creating a block > Define 

the name [000_Section A-A’] > Click [OK] 

(CO 2) Draw an elevation from the floor plan (CO 2) Draw an elevation from the floor plan 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=80 

“An elevation is a view from the side of an object when drawing interior elevations; this would represent one of the walls. 

This would include any windows or doors as well as any built-in furniture that is in direct contact with the wall.” 

Retrieved from https://www.nda.ac.uk/blog/identify-plans-elevations-sections/ 

“The term ‘elevation’ refers to an orthographic projection of the exterior (or sometimes the interior) faces of a building, that 

is, a two-dimensional drawing of the building’s façades.” 

Retrieved from https://www.designingbuildings.co.uk/wiki/Elevations 

In this tutorial, students will draw an interior elevation based on Eames House, House, Section C-C’ drawing, the plan west 

elevation in the living room. Students will not draw a section. You will need to understand the concept of elevation and will 

draw only interior elevation. 
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• [STEP 01] Decide an elevation view. 

• [STEP 02] Draw outline of the elevation by using [xline] to draw the boundary of the elevation. 

• [STEP 03] Rotate and relocate the section view c-c’ from the inserted image to match the boundary of the elevation. 

You will need to rotate 90degree clockwise. 

• [STEP 04] Rotate the copied floor plan and the inserted image to 90degree counterclockwise. The reason for this step 

is to draw the elevation quickly. It typically takes less time to draw the elevation in the right direction (Up-North, 

Down-South, Left-West, and Right-East). 

• [STEP 05] Remove the elements that are not needed from the copied floor plan. Make sure you saved the original floor 

plan. You only delete the elements in the COPIED floor plan. 
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• [STEP 06] Now you can draw the elevation 

◦ Draw floor level and ceiling level (8′ -1″ AFF) (Typically, an interior elevation expresses interior elements only. 

You don’t draw wall thickness, window cut, ceiling structure, and roof structure.) > Change the lines for the wall 

ends, floor level, and the ceiling level to [A-LWT-SECTION] 

◦ Switch the layer to [A-LWT-OBJECT] > Draw wall and furniture by using [LINE], [PLINE], [CIRCLE], [FILLET]. 

[TRIM] 

◦ If needed, switch the layer to [A-LWT-SURFACE] > Draw anything that is not important in terms of construction. 

• [STEP 07] Add dimensions and opening for more information 

◦ On the Application Status Bar, switch the scale to 3/8” = 1’ 0” 

◦ Type [ddim] and press [enter] to open [Dimension Style Manger] 

◦ Click [Annotative-3-32] > click [Set Current] > click [Close] 

◦ Type [dim] and press [enter] to add dimension 

◦ You will need to click the first extension line origin > click the second extension line origin > specify dimension 

line location. Repeat this process to add dimensions for the casework. 

• [STEP 08] Make a block for the elevation. 

◦ Select the elevation, including lines and dimensions. 

◦ Type [b], press [enter] to open [Block Definition] 

◦ Define the name [000_Elevation-A] 

◦ Click [OK] to finish the command 
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• [STEP 09] Organize your drawings. 

◦ Move the inserted – reference images to 75′ plan north. 

◦ Move your section and elevation on the right side of the floor plans. 

(CO 3) Add/Edit Text & Annotation (in model space – annotative) – M Text, (CO 3) Add/Edit Text & Annotation (in model space – annotative) – M Text, 
Text Style, M leader, and Multileader Style Text Style, M leader, and Multileader Style 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=80 

In this tutorial, students will learn how to add and edit text and annotation in the drawing area by using [MULTILINE 

TEXT], [TEXTSTYLE], [MULTILINE LEADER], and [LEADERSTYLE] 
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Add room names and room numbers on the floor plan. 

• [STEP 01] Switch to the [A-ANNO-TEXT] layer 

• [STEP 02] Adjust units by typing [UN] and press [enter] to open [Drawing units]. 

◦ The current unit precision is 0′ -0 1/16″ 

◦ Change the unit precision to 0′ -0 1/32″ 

◦ Click [OK] to close the Drawing units window 

• [STEP 03] Add two text styles for the room names and room numbers 

◦ From the Annotate tab, Text panel on the ribbon, Click [Standard] > Click [Manage Text Styles] 

◦ On [Text Style] window, click [New] 

◦ Enter Style name [Annotative 1-8] and click [OK] 

◦ Confirm [Annotative] is checked, update Paper Text Height to [0′-0 1/8″] 

◦ Click [Apply] 

◦ Click [Set Current] 

◦ Click [New] 

◦ Enter Style name [Annotative 3-32] and click [OK] 

◦ Confirm [Annotative] is checked, update Paper Text Height to [0′-0 3/32″] 

◦ Click [Apply] and click [Close] 
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• [STEP 04] Add room name 

◦ Verify the Text Style is [Annotative 1-8] from [Annotate] tab, on [Text] panel 

◦ Click [Multiline Text] from [Annotate] tab, on [Text] panel 

or, Type [mt] and press [Enter] 

◦ Define a text box for a room name. Using All Caps are recommended for a room name. Sometimes, use an 

acronym. (e.g., LIVING RM) 

◦ Enter [a room name] and click a point outside of the text box. 

• [STEP 05] Add room number 

◦ Verify the Text Style is [Annotative 3-32] from [Annotate] tab, on [Text] panel 

◦ Click [Multiline Text] from [Annotate] tab, on [Text] panel 

or, Type [mt] and press [Enter] 

◦ Define a text box for a room number. 

◦ Enter [a room name] and click a point outside of the text box. Typically, each room requires one number, e.g., 102 

(The first number (1) indicates the floor number. In this case, the living room is located on the first level. The 

second and the third number (02) indicate room number that starts from the main entry to clockwise. In this case, 

the HALL is 101; LIVING RM is 102. 

◦ Draw a box around using [RECTANGLE] 

• [STEP 06] Create a block for the room name and number that you just created. Name the block to [000_Room name 

and number] 

Note. This strategy is useful because once the block is updated on the floor plan, the room names and room numbers 

are automatically updated on other plans like a ceiling plan, finish plan and more. 

• [STEP 07] Use [Edit Block-in Place] to copy the room name and number to all rooms > Edit the names and numbers by 

double-clicking the name and the number > Click [Save Changes] to close [Edit Block-in Place] 

• [STEP 08] Update the block from [A-ANNO-TEXT] layer to [0] layer 
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Add text and annotate on the floor plan 

• [STEP 01] Switch to [A-ANNO] layer 

• [STEP 02] Draw lines for openings and change [line type] to [Dashed] 

• [STEP 03] Add multiline texts 

◦ Add [OPEN TO BELOW] text on the second level above the LIVING RM-102. Make sure the scale is 3/16″ =1′ -0″ 
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while you add the text 

◦ Add [OPEN TO HALL] and [OPEN TO KITCHEN] texts on the [ELEVATION A]. Make sure the scale is 3/8″ =1′ 

-0″ while you add the text 

Add annotates on the elevation A 

• [STEP 01] Switch to [A-ANNO-TEXT] 

• [STEP 02] Click [Manage Multileader Styles] from Annotation tab, Leader panel, under Standard 

• [STEP 03] Click [NEW] > Add a new name for leader style [Annotative 3-32] > Check Annotative box on > Click 

[Continue] 

• [STEP 04] Update these values to 3/32″ – Text height from Content tab, Landing gap from Content tab, Arrowhead 

size from Leader Format, Break size from Leader Format, and Set Landing distance from Leader Structure > Click 

[OK] to close the window 

• [STEP 05] Click [Set Current] 

• [STEP 06] Click [Multileader] from the Annotate tab, on the Leader panel 

or, type [MLD] to add leader and text 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 5. Draw ceiling plans 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Draw RCPs from Floor plans 

(CO 2) Add/Edit Hatch 

(CO 3) Create a legend for the RCPs 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Draw Reflected ceiling plans (RCPs) from floor plans (CO 1) Draw Reflected ceiling plans (RCPs) from floor plans 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=82 

In this tutorial, you will learn how to draw an RCP in AutoCAD. 

Open your AutoCAD file 

Copy elements from the floor plan 

• [STEP 01] Turn layers off that are not needed to copy for the RCPs. 

Turn off the following layers: A-ANNO, A-ANNO-DIMS, A-ANNO-TEXT, ANNO-TTLB, A-CLNG, A-CLNG-

PATT, A-DETL, A-FLOR, A-FLOR-FNSH, A-FLOR-HRAL, A-LWT-OBJECT, A-LWT-SECTION, A-LWT-SURFACE, 

Defpoints, I-FURN, P-FIX, S-LEVEL 

• [STEP 02] Copy the remaining elements to 100’ plan south direction 

• [STEP 03] Turn on all layers 

• [STEP 04] Clean up the plan 

◦ In the space, we want to show all door openings, but not the doors themselves. To remove the door swing, you 

must Explode the door blocks and remove the doors themselves and swings 

◦ For the casework, remove the casework that is not below 5 ft. 

◦ Extend lines as needed to clean up the plan 

• [STEP 05] Lock [S-GRID] layer > Select all walls and elements for the RCPs > Switch to the [A-CLNG] layer. 
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• [STEP 06] Make the [A-CLNG] layer to the Current Layer 

• [STEP 07] Add ceiling elements (height changes and ceiling structure if it is the open ceiling) 

• [STEP 08] Make the [A-CLNG-PATT] layer to the Current Layer > Confirm the layer color to 34 > Add ceiling pattern 

• [STEP 09] Make the [A-CLNG-PATT] layer to the Current Layer > Add ceiling annotation 
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• [STEP 10] Copy the room name and number block from floor plan 
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• [STEP 11] Create Lighting symbols 

◦ You can bring lighting symbols (blocks) from other websites or the samples from Electrical-lighting folders using 

[DESIGN CENTER] 

◦ And you also can make your own symbols for your project. I created eight types of lighting fixtures 

• [STEP 12] Add [A-CLNG-FIXT], color – 190, lineweight – 0.25mm > Place lighting symbols (blocks) in the floor plans 

> Switch the light symbols to [A-CLNG-FIXT] 

• [STEP 13] Select all lighting symbols from the floor plans > Create a block [000-lighting fixtures] > Move the block to 

the RCPs 
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• [STEP 14] Select the block on the RCPs> Mouse right-click > Select [Edit Block in-place] > Adjust and align the 

lighting fixture with add dimensions > Click [Save changes] 
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(CO 2) Add /Edit Hatch (CO 2) Add /Edit Hatch 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=82 

• [STEP 1] Hide unnecessary layers for better hatch results 

◦ Confirm the current layer is [0] layer 

◦ Turn off all layers except [0], [A-WALL], [A-LWT-SECTION], and [A-CLNG] layers 

• [STEP 2] Draw lines or pline to create a closed object 

◦ Hatch only recognizes a closed object. Thus you must make a closed pline or lines that are completely closed. If 

you are unsure the object is closed or not, you have to try the Hatch command first. If the hatch command doesn’t 

work, you have to redraw using [PLINE] or use [PEDIT] to convert from lines to [pline]. 
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• [STEP 3] Add hatch for the wall 

◦ Confirm the current layer is [A-WALL] 

◦ Click the Hatch icon from the [HOME] tab, on the Draw panel 

or, type [H] and press [ENTER] 

◦ Select Solid from the [HATCH EDITOR] tab, on the [PATTERN] panel 

◦ Select color nine from the [HATCH EDITOR] tab, on the [PROPERTIES] panel 

◦ As you move your mouse cursor over a closed object, the hatch pattern fills the area. If you don’t get the preview, 

that means you don’t have a closed object. 

◦ You can select multiple files for one hatch command 

◦ Press [ENTER] to finish the hatch command 

• [STEP 4] Copy wall fills to RCPs 

◦ Select the wall fills you just made. if necessary, you also can make a block for the wall fills by typing [B] and press 

[ENTER] 

◦ Change drawing order to [SEND TO BACK] by clicking mouse right-click and select [SEND TO BACK] 

◦ Copy the wall fills from the floor plans to the RCPs 
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• [STEP 5] Add hatch for the section view 

◦ Select the section view 

◦ Mouse right-click > select [EDIT BLOCK IN-PLACE] > Click [OK] 

◦ Draw lines or polylines to make a closed object. Make sure you are in a correct layer 

◦ Select [HATCH] icon from [HOME] tab, on [DRAW] panel 

or, Type [H], and press [ENTER] key 

◦ Select a closed wall, floor, ceiling area. You can select multiple areas for one hatch—Press the [ENTER] key to 

finish the comment. 

◦ Update the hatch fill layer to [A-LWT-SECTION] 

◦ Once you finish hatching, click [SAVE CHANGES] to save the block > Click [OK] 

• [STEP 6] Turn on all layers 

The Hatch command is to fill an enclosed area or a selected-closed object with hatch patterns or fill. 
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Hatch is often used to add a fill to the wall, floor, and ceiling thickness for better readability. 

Moreover, the hatch is also used to add patterns on a surface to express the finishes. 

In this tutorial, you will practice adding solid fills on the wall of the floor plans and RCPs. This is commonly referred to as 

poche. Additionally, add a hatch pattern on the wall, floor, and ceiling of the section view. 

(CO 3) Create a legend for the RCPs (CO 3) Create a legend for the RCPs 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=82 

In your RCPs, a legend is necessary to inform what items are included, such as lighting fixtures, finishes, equipment, HVAC, 

and more that are used in your RCPs. 

In this tutorial, you will make a lighting legend that you used in your RCPs 

• [STEP 1] Find/organize the lighting fixtures that you used 

◦ Copy the lighting block from the RCP to an empty drawing area 

◦ Explode the lighting block by typing [X] and press the [ENTER] key 

◦ Remove all dimensions from the exploded lighting block. You can lock the [A-CLNG-FIXT] > select the 

dimensions > delete the selected dimensions by press the [DELETE] key, or type [ERASE] and press the [ENTER] 

key 

◦ Delete duplicated lighting fixtures. You only need one lighting fixture block of each lighting fixture type. 

◦ Organize the lighting fixtures vertically. You can draw a line for a reference. 
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• [STEP 2] Create a table with lines 

◦ AutoCAD offers a Table tool to create a table. You can find the tool from the [ANNOTATE] tab under the 

[TABLES] panel. However, this table tool is used for very complicated documents. As an interior designer with 

more than ten years’ experience in the industry, I still use lines to create a table. Please try the table tool if you 

want. 

◦ Copy the reference line for the column lines for the table. You can use the [OFFSET] command, too. 

◦ Draw rows with lines 

◦ To clean up lines, use [TRIM] commands 
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• [STEP 3] Add texts to the table 

◦ Make sure your drawing scale is 3/16”=1’-0.” 

◦ Type [MT] and press [ENTER] to draw a text box and add text 

◦ Repeat the [MTEXT] command for other text. You also can copy from what you created. 

• [STEP 4] Select the table and table contents > Switch to [A-ANNO] layer 

• [STEP 5] Make the table as a block [000-Lighting Legend] 
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SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 6. Set sheets 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Understand Model space and Paper space 

(CO 2) Set a new layout – Page layout and plot styles 

(CO 3) Set views in Paper space – Defpoints, scaling 

(CO 4) Add/Edit/Draw a titleblock 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Understand Model space and Paper space (CO 1) Understand Model space and Paper space 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=84 

In this tutorial, you will understand the differences between the concept of model space and the concept of paper space. 

AutoCAD provides two different types of drawing areas. 

• Model space – A limitless drawing area. You draw at a 1:1 scale. 

• Paper space – To prepare your drawing for printing, use paper space. Paper space is a pre-defined and set area. Please 

refer to the information from this link. 

Clean up the CAD file 

• Purge is a command to automatically removed all layers, blocks, dimension styles, and more items that are not 

currently used in your document. This command is a useful command to reduce the file size. 

• Type [PURGE], and press [ENTER] key, select [PURGE ALL], and purge all again until the [PURGE ALL] is grayed out. 
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(CO 2) Set a new layout – Page setup (CO 2) Set a new layout – Page setup 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=84 

In this tutorial, you will understand how to set a new layout in the paper space using page setup. 

Once you click [LAYOUT 1], you will see the models you made in the model space in a rectangular box. It is called a viewport. 

There is a dashed line that is inside of the white space; it is called a printable area. 

And the white space called a layout. Once you change the paper size to print, the layout and the printable area will change 

accordingly. 

Update Page setup for 11in x 17 in PDF 

• [STEP 1] Open Page setup manager 

◦ Mouse right-click on [LAYOUT 1] 

◦ Click [PAGE SETUP MANAGER] 

◦ Click [*Layout1*] and select [MODIFY] to open the Page setup 

• [STEP 2] Edit Page Setup 

◦ Click the name of printer/plotter and switch to [DWG To PDF.pc3] 

◦ Update paper size to [ANSI full-bleed B (17.00 x 11.00 Inches) 

◦ Confirm What to plot: [LAYOUT] 

◦ Confirm Plot scale to [1:1] 

◦ Change Plot style table to [monochrome.ctb] 
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◦ Check [Display plot styles] 

◦ Check [Landscape] for the drawing orientation 

◦ Click [OK] – Page Setup – Layout 1 

◦ Click [Close] – Page Setup Manager 

• [STEP 3] Confirm the layout with an updated sheet size 

• [STEP 4] Update the name of the sheets and add sheets 

◦ To update the name of sheet > mouse-right click on the tab > Click [RENAME] > Rename on the tab 

◦ To add a sheet > click [+] tab 

▪ Update the name of Layout1 to A101. A101 is for the floor plans 

91  |  AutoCAD Session 6



▪ Update the name of Layout2 to A102. A102 is for the furniture plans 

▪ Add a new layout and change the name to A401. A401 is for RCPs 

▪ Add a new layout and change the name to A601. A601 is for the section view and the elevation 

• [STEP 5] Update other sheets to 11×17 PDF 

◦ Mouse right-click on A102 

◦ Open Page Setup Manger 

◦ Select *A101* 

◦ Click [Set Current] 

◦ Click [Close] 

◦ Repeat this process for A401 and A601 

(CO 3) Add/Edit/Draw a titleblock (CO 3) Add/Edit/Draw a titleblock 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=84 

• [STEP 1] Draw a titleblock 

◦ Select [A101] sheet to open the sheet 

◦ Confirm your current layer is [0] 

◦ Draw a rectangle for a paper size box – Type [REC], press [Enter] key > Type [0,0], press [Enter] key > Type 

[17”,11”]. Press [Enter] key 

◦ Draw a titleblock outline using the paper size box – Type [O], press [Enter] key > Type [1/4”], press [Enter] key > 

Click the inside of the sheet 

◦ Draw lines for the titleblock. Please refer to the image below 
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• [STEP 2] Add titleblock information 

◦ Sheet number – A101 

◦ Project name – Eames House, House 

◦ Your name – First name and last name 

◦ Course number 

◦ Submission date 

◦ Add text using [MT] for titleblock information. Verify the text size is 3/32”. You may rotate the text 90 degrees. 

• [STEP 3] Add the titleblock to other sheets 

◦ Click [Inset] from [Insert] tab, on [Block] panel 

◦ Select [000_Titleblock_11x17] 

◦ Type [0,0], press [Enter] key 

◦ Select the titleblock and the information except for the Sheet number. 

◦ Create a block for the selected elements – Name the block – [000_Titleblock_11x17] 

◦ Insert the titleblock to A102, A401, and A601 

◦ Switch the Titleblocks to [A-ANNO-TTLB] 

◦ Copy and modify the sheet number to A102, A401, and A601 

• Now you are ready to add a titleblock on the paper space. 
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(CO 4) Set views in Paper space – Defpoints, scaling (CO 4) Set views in Paper space – Defpoints, scaling 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=84 

Now you are ready to set the views in the sheets 

• [STEP 1] Change a viewport size and the viewport layer 

◦ Once you click, a viewport can be changed by stretching the corner of the viewport line. 

◦ Select the viewport > switch to [Defpoints] layer. The [Defpoints] layer is set up by default as a non-plot layer. 

• [STEP 2] Update the scale of the viewport 

◦ After changing the viewport size > double-click the viewport > Zoom in and out > Pan the view to make the view 

centered 
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◦ Click a scale on the application status bar, and select a desired scale for the floor plan 

◦ If the dimensions have disappeared, click on the Show Annotation icon on the application status bar 

• [STEP 3] If you want to add a new viewport, use the [MVIEW] command. 

◦ Type [MV], and press [Enter] > Click the first point to draw a rectangle > Click a second point to finish the 

rectangle. It will automatically show the drawings 

◦ If you have a viewport to copy, you can copy the viewport and pan the view 

◦ Sometimes a copied viewport will show in color. To change it to black and white, double-click the inside of the 

viewport > type [RE] and press [ENTER] key > double-click the outside of the viewport 
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• [STEP 4] Update layer visibility for the viewports 

◦ Open [LAYER PROPERTIES MANAGER] 

◦ A101 is for dimensioned floor plans. Thus, it would help if you hid the [I-FURN], [I-CASE], and [P-FIXT] layers 

◦ Double-click the viewport, and click [VP FREEZE] on the I-FURN], [I-CASE], and [P-FIXT] layers 

• [STEP 5] Set a furniture plan sheet 

◦ The scale of the furniture plan is 3/16”= 1.’ 

◦ VP Freeze [A-ANNO], [A-ANNO-DIMS], [S-GRID], and [S-LEVEL] 

• [STEP 6] Set an RCP sheet 

◦ The scale of the RCP is 3/16”= 1.’ 
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• [STEP 7] Set a section view and elevation sheet 

◦ The scale of the section view is 3/16”= 1.’ 

◦ The scale of the elevation is 3/8”= 1.’ 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 7. Symbols and prints 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Add/Edit symbols in Paper spaces – drawing title, elevation symbol and section letters, north arrow 

(CO 2) Printing 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Add/Edit symbols in Paper spaces- drawing title, elevation symbol and (CO 1) Add/Edit symbols in Paper spaces- drawing title, elevation symbol and 
section letters, north arrow section letters, north arrow 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=86 

Open your AutoCAD file. 

Add drawing title and scale for Floor plans, Furniture plans, RCPs, Section view, and elevation 

• [STEP 1] Click [A101] sheet to open the view 

• [STEP 2] Open [DESIGN CENTER] 

• [STEP 3] Find [A-01.dwg] for a sample drawing title 

◦ Click the [HOME] icon 

◦ Open [Sheet Sets] > [Architectural] > [A-01.dwg] 

◦ Open [Blocks] 

◦ Double click [Drawing Title] 

• [STEP 4] Add on the sheet 

• [STEP 5] Double-click the inserted drawing title and edit the attribute. Adjust the title line length 

• [STEP 6] Copy the edited drawing title for the 2nd-floor plan and double-click to edit the drawing title 

• [STEP 7] Repeat [STEP 6] for other drawings 

• [STEP 8] Update the drawing titles to the [A-ANNO] layer 
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Add an elevation symbol from [TOOL PALETTES] 

• [STEP 1] Open [TOOL PALETTES] from [VIEW] tab, on [PALETTES] 

• [STEP 2] Click [Annotation] tab from [TOOL PALETTES] 

• [STEP 3] Select [CALLOUT BUBBLE – IMPERIAL] 

• [STEP 4] Add the symbol on the first floor 

• [STEP 5] Double-click to open the attribute editor, and update information 

• [STEP 6] Update scale to 0.75 

• [STEP 7] Update the symbols to the [A-ANNO] layer 

Add section letters with [MTEXT] 

• [STEP 1] Type [MT], press [ENTER] key 

• [STEP 2] Draw a text box to add the section letter 

• [STEP 3] Text size update to 1/8” 

• [STEP 4] Add section letter 

• [STEP 5] Repeat this process for other sections 

• [STEP 6] Update section letter to [A-ANNO] layer 

Add north arrow with drawing tools [LINE], [CIRCLE], [MTEXT], & [HATCH] 

• [STEP 1] Draw a north arrow in the paper space and make a block 

• [STEP 2] Rotate the north arrow to match the information from Eames House plan images 

• [STEP 3] Place the north arrow to Floor plans, Furniture plans, RCPs 
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(CO 2) Printing (CO 2) Printing 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=86 

Update the print setup for each layout 

• [STEP 1] Open [PAGE SETUP MANAGER] by mouse right-click on each layout. 

• [STEP 2] Click [Modify] to open [Page setup] 

• [STEP 3] Plot style table is already set to Monochrome.ctb. The Monochrome style turns all layer colors to black. Since 

we don’t want our wall, floor, and ceiling thickness to be black, we need to customize the plot style. 

• [STEP 4] Click the edit button next to the name 

• [STEP 5] Click [Color 9] from [PLOT STYLES] and change to [USE OBJECT COLOR] 

• [STEP 6] Click [SAVE & CLOSE] 

• [STEP 7] If the color is not changed automatically on your paper space, use the [REGEN] command for the views. 
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Print a single sheet 

• [STEP 1] Click a layout that you want to print 

• [STEP 2] Press [CTRL+P] to open [PLOT] 

• [STEP 3] Click [PREVIEW] from the [PLOT] window 

• [STEP 4] Click [OK] > find a location to save > click [SAVE] 

Print multiple sheets at once 

• [STEP 1] Click [Home] button > Select [Publish] to open [PUBLISH] window 

• [STEP 2] Select the drawing model if it shows, and mouse right-click > click [Remove] 
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• [STEP 3] Click [PUBLISH] 

• [STEP 4] Specify the file location to save > click [SELECT] 

• [STEP 5] If you want to save the current list of sheets for later use, click [Yes] 

• [STEP 6] Click [close], once a processing background job window popup 

• [STEP 7] Wait until the completion message comes 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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PART TWO. REVIT 

Chapter 8. Introduction to Revit Chapter 8. Introduction to Revit 

• Purpose of using Revit – How & Why Interior Design uses Revit 

• Install Revit 

• Understand Project Templates – Default and Own 

• Save Revit file – Set the project folder and backup file 

• Open an existing project file 

• Keyboard shortcuts 

• Understand the User Interface – Toolbar, Properties, Drawing area, Option bar, and Project Browser 

Chapter 9. Chapter 9. Create a Site Create a Site 

• Understand the site plan and information 

• Set the project location and understand building base point 

• Find GIS information 

• Add & Edit Site – Topo surface, roads, side works, property line, building pod, surrounding buildings, and trees 

• Define true north and project north 

Chapter 10. Chapter 10. Set Grids, Levels, Dimensions, & Building columns Set Grids, Levels, Dimensions, & Building columns 

• Import CAD drawings– Floor plans, building elevations, and sections 

• Adjust and verify the scale 

• Create and modify grids and levels 

• Create plan views– Floors and ceilings 

• Create columns with dimensions 

Chapter 11. Chapter 11. Add/Edit Beam, Walls, & Curtain Walls Add/Edit Beam, Walls, & Curtain Walls 

• Add/Edit Beam 

• Create walls 

• Edit walls wall properties – Wall thickness, Wall details, & Finishes 

• Edit/add wall properties – Wall opening, wall sweep 

• Add/Edit Curtainwalls, Mullions, & Panels 
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Chapter 12. Chapter 12. Understand Visibility settings, Add/Edit Floor & Ceiling Understand Visibility settings, Add/Edit Floor & Ceiling 

• Understand View template, visibility graphics 

• Understand View range 

• Add/Edit Floors  & Floor Properties 

• Add/Edit Ceilings & Ceiling Properties 

Chapter 13. Chapter 13. Add/EditAdd/Edit  Stairs, Rails, & Roof Stairs, Rails, & Roof 

• Add/Edit Stair – three types of staircases 

• Add/Edit Railing 

• Add/Edit Roof 

Chapter 14. Chapter 14. Add/Edit Windows, Doors, Lighting Fixtures, Furniture, Tags, & Add/Edit Windows, Doors, Lighting Fixtures, Furniture, Tags, & 
Sheets Sheets 

• Understand the concept of family file 

• Add/Edit Doors and Windows 

• Add Tags 

• Add/Edit Lighting fixtures 

• Add/Edit Titleblocks 

• Insert Plan views and symbols – North arrow and graphic scale 

Chapter 15. Chapter 15. Add/Edit Model-in-Place Components & Edit Family Add/Edit Model-in-Place Components & Edit Family 

• Add/Edit Furniture families 

• Add/Edit Model-in-place components – Custom casework 

• Add/Edit a New Family – Furniture 
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Chapter 16. Chapter 16. Add/Edit Elevation, Section, Detail, Text, Annotation, & Rooms Add/Edit Elevation, Section, Detail, Text, Annotation, & Rooms 

• Add/Edit Elevations & Sections – Adjust crop region 

• Add/Edit Detail views 

• Add Texts & Annotations 

• Add/Edit Rooms, Room tags, Room separators 

• Add/Edit a color fill scheme 

Chapter 17. Chapter 17. Add/Edit Views, Lighting, & Materials Add/Edit Views, Lighting, & Materials 

• Set perspective views 

• Set Isometric views 

• Edit Views – Graphic Display styles 

• Test Render 

• Set sun 

• Edit Artificial lighting 

• Add/Edit materials 

• Render material managements 

Chapter 18. Chapter 18. Create Revit Rendering, Revit Clouding Rendering Create Revit Rendering, Revit Clouding Rendering 

• Insert other types of files – Sketchup, AutoCAD 

• Advanced render settings 

• Edit render qualities 

• Understand and make cloud renderings 

• Save Rendering outputs 

 

107  |  Part Two. Revit



Chapter 8. Introduction to Revit 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Purpose of using Revit – How & Why Interior Design uses Revit 

(CO 2) Install Revit 

(CO 3) Understand Project Templates – Default and Own 

(CO 4) Save Revit file – Set the project folder and backup file 

(CO 5) Open an existing project file 

(CO 6) Keyboard shortcuts 

(CO 7) Understand the User Interface – Toolbar, Properties, Drawing area, Option bar, and Project Browser 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Purpose of using Revit – How & Why Interior Design uses Revit (CO 1) Purpose of using Revit – How & Why Interior Design uses Revit 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88 

Introduction of Revit, a BIM (Building Information Model) software 

• Charles River Software originally developed the software in 1997, renamed Revit Technology Corporation in 2000, 

and acquired by Autodesk in 2002. 

• Autodesk Revit is BIM software for Architects, Interior Designer, Landscape Architects, Structural Engineers, MEP 

Engineers, Contractors, and more. 

• Revit can be used as a very powerful collaboration tool among different disciplines in the Architecture, Engineering, 

and Construction (AEC) industry. 

image credit: https://commons.wikimedia.org/wiki/File:Revit.jpg 

• Revit has a huge library for modeling in the software itself and supports plug-ins, advanced data management systems, 

and energy modeling analysis. 

• Revit modeling process is complicated and not easy for a first-time user. 

• Software required better hardware, 40% more expensive than Autodesk CAD but higher productivity. 

• For architects and interior designers, the software is being used to create construction documents. 
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• Most of the commercial interior design/architectural design firms use Revit. 

• Not much of renderings features, but support Virtual Reality plugins. 

• Collaborate with CAD drawing users. 

(CO 2) Install Revit (CO 2) Install Revit 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88 

Install Autodesk Revit 

• [STEP 1] Go to https://www.autodesk.com/education/free-software/revit on your window side in a web browser. 

• [STEP 2] Click [CREATE ACCOUNT] if you do not have one. If you have the account, please sign in. 

• [STEP 3] Click [Get product] under Revit. 

• [STEP 4] Select, windows, 2021, and English. Click [INSTALL]. 

• [STEP 5] Accept the license and services agreement. 

• [STEP 6] You will get an email from Autodesk for the license information (Product key and Serial Number). It may 

need the information for the activation process. 

• [STEP 7] Click Install. 

• [STEP 8] Click downloaded installation file to install. 

• [STEP 9] Setup Initialization will download actual software to install it will take time. 

• [STEP 10] While you are installing Select the “Architecture” discipline in the drop-down menu. 

• [STEP 11] After installation, the license information required to activate Revit. 

(CO 3) Understand Project Templates – Default and Own (CO 3) Understand Project Templates – Default and Own 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88 

Open Revit by double-clicking the Revit Icon. 

Once the application opens you can see the HOME page. From the home page, you can open recent project files and recent 

family files. Also, you can create a new project file or a new family file. 

Create a new project file with Architecture Template. 

• [STEP 1] Click [NEW] under Models on the left side of the Home page 

• [STEP 2] Click [Imperial-Construction Template] and select [Imperial-Architectural Template] 

• [STEP 3] Click [OK] to create a new project file. 
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If you are working on a specific project like a residential building or a commercial project, there are more templates that 

Autodesk supports. To open the template, you can click [BROWSE]. And see what template is appropriate for your project. 

Additionally, you can also create a project template for your firm. Many firms already created/use their own template (called 

a seed file) to save time and resources to develop their construction documents. 

(CO 4) Save Revit file – Set the project folder and backup file (CO 4) Save Revit file – Set the project folder and backup file 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88 

Saving a file must be a friend of yours. Once you create a new file you must save the Revit file first and work on it later. 

Save a file for the first time 

• [STEP 1] Click [FILE] tab 

• [STEP 2] Select [SAVE AS] from the file menu 

• [STEP 3] Select [Project] under the menu 
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• [STEP 4] Find a folder location to save. If you do not have a folder, you can create a folder by pressing [ALT+5]. it is 

recommended to have a project folder to save the project Revit file. You also save other family files (e.g. Furniture, 

lighting family that you downloaded) and material images that you found under the project folder. You may draw and 

drop the folder to the left side of the browser for future use. 

Tip, I strongly recommend having an external hard drive to save files. If your laptop hard disk is full, your hardware 
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performance will be drastically reduced. To prevent this, your working file should be saved in an external hard disk. For 

extra safety, it is recommended to use Cloud file storage to save files. 

• [STEP 5] Open a folder to save and make a unique name for the project. 

• [STEP 6] Before you click [SAVE], you may consider saving a backup file by clicking [OPTIONS]. Revit will 

automatically make backup project files. It is safe to have the backup files, but it will take time for the automatic 

backup file while you work on it. You may set the number of backup files (default is 20) by open [Option] in the save as 

browser. 5 backup files might be enough. 

Save a file while working or end of the work 

• [STEP 1] Click [FILE] tab 

• [STEP 2] Select [SAVE] or simply press [CTRL + S] 

(CO 5) Open an existing project file (CO 5) Open an existing project file 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88 

Revit has 2 ways to open your project file. 

The first method is just double-clicking your Revit project file. 
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The second method is opening a file in the application. I recommend this second option due to reducing errors that you 

might have, especially, while you are sharing a file with your co-workers. 

• [STEP 1] Open the Revit software 

• [STEP 2] Click [File] on the tab 

• [STEP 3] Click [Open] on the file tab 

• [STEP 4] Select the file that you want to open under the folder 

• [STEP 5] Click [Open] to open the file 

(CO 6) Keyboard shortcuts (CO 6) Keyboard shortcuts 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88 

To increase productivity, I recommend you become familiar with the following keyboard shortcuts. 

• MV       Move 

• TL        Thin Line 

• VV       Visibility 

• ZE        Zoom All to fit 

• WT      Tile Views 

• TW      Tab Views 

• DI         Aligned Dimension 

• DL       Detail Line 

• CO       Copy 

• RO       Rotate 

• MA      Match type properties 

• AL       Align 

• PT       Paint 

For more information regarding shortcuts 

https://www.autodesk.com/shortcuts/revit 

(CO 7) Understand the User Interface – Toolbar, Properties, Drawing area, (CO 7) Understand the User Interface – Toolbar, Properties, Drawing area, 
Option bar, and Project Browser Option bar, and Project Browser 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=88 
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Revit’s user interface is similar to AutoCAD’s one including an icon with text, and wording. 

You may change the location of Properties and Project Browser to expand more drawing area. 
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You also can change the Ribbon panel size by clicking the minimize panel button. 

If you accidentally close Properties or Project Browser, you can open with [User Interface] 

Select [VIEW] tab > Click [USER INTERFACE] > Check the box to open. 

image credit: Screen captured and modified by the Author from the application 

In the ribbon, you will find many tools for your work. 

• Architecture 

• Insert 

• Annotate 

• Analyze 

• Massing & site 
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• Collaborate 

• View 

• Manage 

• Add-Ins 

• Modify 

For more information regarding the user interface, please read this page 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 9. Create a site 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Understand the site plan and information 

(CO 2) Set the project location and understand building base point 

(CO 3) Import google maps and define true north & project north 

(CO 4) Find GIS information 

(CO 5) Add & Edit Site – Topo surface, roads, side works, property line, building pod, surrounding buildings, and trees 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Understand the site plan and information (CO 1) Understand the site plan and information 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=90 

The site plan is an architectural plan of proposed improvements to a given lot. A site plan usually shows a building footprint, 

travel ways, parking, and landscaping and garden elements (Department of Building and Development Land Development, 

2009). 

image credit: Archibald & Fraser Architects Ltd. – Wikimedia Commons – File: Lochaber Centre Site Plan.jpg 

A site plan is a “set of construction drawings that a building or contractor uses to make improvements to the property. 

Counties can use the site plan to verify that development codes are being met and as a historical resource. Site plans are often 

prepared by a design consultant who must be either a licensed engineer, architect, landscape architect, or land surveyor” 

(Chesterfield County, 2009). 

A site plan is a top view of a property that is drawn to scale. A site plan can show 
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• Property lines 

• Outline of existing and proposed building and structures 

• Parking lots, indicating parking spaces 

• Driveways 

• Surrounding streets 

• Landscaping areas 

• Terrains 

(CO 2) Set the project location and understand building base point (CO 2) Set the project location and understand building base point 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=90 

Draw the building footprint for the site plan 

• [STEP 1] Acknowledge the overall size of the building. 

◦ The size of the house part of the Eames House project is 58’-7” x 20’-4.” 

• [STEP 2] Select [WALL] from [ARCHITECTURE] tab, under [Build] panel 

Or, Type [WA] on your keyboard 

◦ Draw only overall exterior walls on level 1 

◦ Make sure your walls are [Project North] on the [Properties] palette. 

◦ Confirm the wall is – Basic Wall/Generic-8”, Unconnected Height 20’ 0.” 
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• [STEP 3] Draw the building footprint 

◦ Click a drawing area 

◦ Move the mouse to the right-side 

◦ Enter 58’7” on your keyboard > press [ENTER] key 

◦ Move your mouse to the down-side 

◦ Enter 20’4” on your keyboard > press [ENTER] key 

◦ Move your mouse to the left-side 

◦ Click the third point and forth to create the building 

• [STEP 4] Move the elevation symbols closer to the close the building 

◦ Select one elevation symbol 

◦ Type [MV] 

◦ And click one point and move the mouse and click the target point to complete the command. 

◦ Repeat this process to other elevation symbols 

Set the project location 

This setting is for sun orientation and weather information 

• [STEP 1] Select [LOCATION] from [MANAGE] tab, under [PROJECT LOCATION] 

• [STEP 2] Enter the project address (Eames House address is 203 N. Chautauqua Blvd. Pacific Palisades, CA) and Select 

[SEARCH] 

• [STEP 3] Select a Weather Station near the project location 

• [STEP 4] Click [OK[ to complete the command 
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(CO 3) Import google maps and define true north & project north (CO 3) Import google maps and define true north & project north 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=90 

Save site information from Google Map 

• [STEP 1] Open your web browser and go to [GOOGLE MAP] – https://www.google.com/maps 

• [STEP 2] Search the address [for Eames House project, 203 N. Chautauqua Blvd. Pacific Palisades, California] 

• [STEP 3] Use [Snipping tool] (search Snipping tool from your program list) – Screenshot – must include the building, 

and the property line, and the scale on the bottom left corner. For your drawing accuracy, I recommend saving both 

the map image and the satellite map image. 

image credit: search result from Google map 

• [STEP 4] Save the snipped image file in JPG file format in your project folder 

Insert site information from google map 

• [STEP 1] Open [SITE] plan by double-clicking from the [PROJECT BROWSER] 

• [STEP 2] Move the project origin to the building bottom left corner 

• [STEP 3] Change the orientation to [TRUE NORTH] 
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• [STEP 4] Select [IMPORT IMAGE], from [INSERT] tab 

• [STEP 5] Open the project folder and select the google map and click [OPEN] 

• [STEP 6] Click on the center of the drawing area 

• [STEP 7] Repeat this process for the satellite map 

Adjust the scale of the imported google map 

• [STEP 1] Select the two imported maps by crossing selection 

• [STEP 2] Click [SCALE] from [MODIFY/RASTER IMAGE] tab, under [MODIFY] panel 

or, Type [RE] for adjusting the scale 

• [STEP 3] Zoom-in to find the graphic scale on the bottom right side of the map 
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• [STEP 4] Click 0ft – click 50 ft – type 50’ – Enter 

• [STEP 5] Move the imported raster maps to be centered 

Adjust the orientation of the imported google maps according to the building footprint 

• [STEP 1] Select the imported google maps 

• [STEP 2] Select [ROTATE] from [MODIFY] tab, under [MODIFY] panel 

Or, Type [RO] on your keyboard 

• [STEP 3] Select [PLACE] 

• [STEP 4] Click the base point to rotate, click an appropriate point to rotate. 

Remember how many degrees you rotated (for Eames House, 75.56 clockwise) 

125  |  Revit Session 2



• [STEP 5] Relocate the imported google maps, if needed 

• [STEP 6] Select only the satellite map > click [SEND TO BACK] from [MODIFY/RASTER IMAGE] under [ARRANGE] 

panel 

• [STEP 7] Select the project base origin 

• [STEP 8] Click [ANGLE TO TRUE NORTH] 

• [STEP 9] Type [-75.56], and press [ENTER] key (for Eames House, we rotated the google images to 75.56 clockwise, so 

you need to re-rotate the origin to 75.56 counter-clock-wise) 

• [STEP 10] Change the view to [PROJECT NORTH] from the [PROPORTIES] to check the plan rotated the right-way. 

Revit Session 2  |  126



• [STEP 11] Change the view to [TRUE NORTH] from the [PROPORTIES] for the site plan 

Crop the view to only the site plan area 

• [STEP 1] Select [CROP VIEW] and [CROP REGION VISIBLE] from the [PROPERTIES] panel 
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• [STEP 2] Adjust the region for the view 

(CO 4) Find GIS information (CO 4) Find GIS information 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=90 

In this tutorial, we will find GIS information from CADMAPPER 

• [STEP 1] Open your web browser, go to https://cadmapper.com/ 

• [STEP 2] Sign up for free if you don’t have an account. Sign on the website. 

• [STEP 3] Enter the project address [203 N. Chautauqua Blvd. Pacific Palisades, CA] and search 

• [STEP 4] Adjust the area for your project by zooming in and changing the selected area. It is free up to 1 km2 

• [STEP 5] Click [CREATE FILE] to generate the 3D model 
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image credit: Screen captured from www.cadmapper.com 

• [STEP 6] You can see the preview for your confirmation. Click [DOWNLOAD] 

image credit: Screen captured from www.cadmapper.com 

• [STEP 7] Once the download is done, open the folder to extract the zip file 
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image credit: Screen captured from www.cadmapper.com 

• [STEP 8] Extract the zip file 

• [STEP 9] Copy the files to your project folder and read the License.txt file before you use the file 
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• [STEP 10] Open the LEVEL 1 view 

• [STEP 11] Click [IMPORT CAD], from [INSERT] tab, under [IMPORT] panel 

• [STEP 12] Open the project folder, change the file type to [DXF files], change colors to [Black and White], change 

Import units to [meter], Click [OPEN] 

• [STEP 13] Move the imported CAD site information to the site. To move the map, you have to unpin before you move 

the site. 

• [STEP 14] Switch the view to [SITE] view, Uncheck [CROP VIEW] from [PROPERTIES] 

• [STEP 15] Rotate the imported CAD site map to match the imported GOOGLE MAP (75.56 degrees clockwise) 

• [STEP 16] Move the imported CAD site map to match the imported GOOGLE MAP. 

◦ To move correctly, you can switch the graphic display option to [WIREFRAME] 

◦ Refer to other building locations and road locations to get the right location aligned 
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• [STEP 17] Open [WEST] view 

• [STEP 18] Move the imported CAD site map to match the building level 1 

◦ You can type the Base Offset or manually move to match 

(CO 5) Add & Edit Site – Topo surface, roads, side works, property line, building (CO 5) Add & Edit Site – Topo surface, roads, side works, property line, building 
pod, surrounding buildings, and trees pod, surrounding buildings, and trees 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=90 
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Create a TOPO SURFACE 

Note, Building sight might be completely flat or with little level change. Please try the TOPO SURFACE tool to make the 

site model. 

• [STEP 1] Select [TOPOSURFACE], from [MASSING & SITE] under [MODEL SITE] 

• [STEP 2] Select [CREATE FROM IMPORT], from [MODIFY/EDIT SURFACE] under [TOOLS] 

• [STEP 3] Select [SELECT IMPORT INSTANCE] 

• [STEP 4] Select the imported CAD site map 

• [STEP 5] Only check [COUNTOURS] from the ADD POINTS FROM SELECTED LAYERS] window 

• [STEP 6] Adjust point locations if needed 
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• [STEP 7] Click the green check to complete the topo surface tool 

Edit TOPO SURFACE 

• [STEP 1] If you want to edit the topo surface, select the topography and select [EDIT SURFACE] 

• [STEP 2] If you want to add the point, use [PLACE POINT] 

• [STEP 3] If you want to remove the point, select the point and press the [DELETE] key 

Topography line setting 

• [STEP 1] Select [SITE SETTING] from [MASSING & SITE] tab, under [MODEL SITE]. 

◦ It is a small arrow on the panel 

• [STEP 2] Set your topo lines 

The increment number depends on your site map scale and how much detail you want to express 
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• [STEP 3] Select [EDIT] for [VISIBILITY/GRAPHICS OVERRIDE] 

Find [TOPOGRAPHY] 

PRIMARY CONTOURS – SOLID / SECONDARY CONTOURS – DASH 

Clean up the imported CAD map 

• [STEP 1] Select the imported CAD map 

• [STEP 2] Click [DELETE LAYERS] from [MODIFY], under [IMPORT INSTANCE] 

• [STEP 3] Check all except [BUILDING] 
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• [STEP 4] Click [OK] to finish the command 

• [STEP 5] Check [CROP VIEW] to see only the region inside 

Confirm your topo in 3D 

Revit is BIM software. Your 2D drawings can show in 3D. It is wise to double-check in 3D view while you build your model 

• [STEP 1] To create a 3D view, click the 3D view on the top of the program 
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• [STEP 2] Once you click the 3D view, the 3D view will automatically open. To refer back to this view, you can open the 

3D view on Project Browser by double-clicking. If you want to keep the view, you must rename the 3D view. For 

example, ISO-view-01 

• [STEP 3] Click [SHADED] to see the color 

• [STEP 4] Check [Section box] on the Properties and adjust the Section box by adjusting the blue arrow 
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• [STEP 5] Click [Sun path On] 

• [STEP 6] Click Shadow 

• [STEP 7] Now you can simulate the sun path by drag and dropping the sun 

Create Building Pod & Property line 

For the building pod and property line, you should hide the Topo image by clicking the image, and mouse right-click and 

select [Hide in view] > [Elements] 

• [STEP 01] Go to Site & massing tab – Click [Building Pad] 

• [STEP 02] Make sure your building pod is on level 1 

• [STEP 03] Draw a closed line 

• [STEP 04] Go to Site & massing tab – Click [Property Line] – Create by sketching 
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• [STEP 05] Use Google Map to draw the property line. Draw a closed line 

Create Roads 

• Go to Site & massing tab – Click Subregion 

• Draw a closed line 

Create Neighborhoods (Trees) 

• Go to Site & massing tab – Click Site component 
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Once you finished your site plan, you should hide the Google image. 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 10. Set grids, levels, dimensions, & 
building columns 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Import CAD drawings- Floor plans, building elevations, and sections 

(CO 2) Adjust and verify the scale 

(CO 3) Create and modify grids and levels 

(CO 4) Create plan views- Floors and ceilings 

(CO 5) Create columns 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Import Drawings- Floor plans, building elevations, and sections (CO 1) Import Drawings- Floor plans, building elevations, and sections 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=92 

Prepare Drawings before import CAD drawings 

• [STEP 1] Open Revit application > Open your project > Double-click [LEVEL 1] from [PROECT BROWSER] > Close 

all other views except [LEVEL 1] 

• [STEP 2] Select [SITE] information including the property line, trees, and neighborhood buildings > Mouse right-click 

on one of the selected elements > select [HIDE IN VIEW] > Select [ELEMENTS] or [CATEGORY] 

Repeat this process for FLOOR PLAN – LEVEL 2, ELEVATION – EAST, WEST, NORTH, SOUTH, CEILING PLAN – 
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LEVEL 1, LEVEL 2 

Insert drawings 

In this tutorial, we will practice how to add an image (drawing) to the view. You can insert CAD files and PDF files 

• [STEP 1] Select [IMPORT IMAGE] from [INSERT] tab, under [IMPORT] panel 

Note. Revit can import various file types – dwg, dxf, pdf, jpg, tif, rvt, and more 

Note. For this project, I will use [tif] files 

• [STEP 2] Find the folder where the drawings are saved > select the floor plan > click [OPEN] > place the imported 

image on the view [LEVEL 1] 

Repeat this process for FLOOR PLAN – LEVEL 2, ELEVATION – EAST, WEST, NORTH, SOUTHNote. The imported 

image will only show on the view where you placed. 

Note. To use the image file that you imported for your other level like [LEVEL 2]. Click [MANAGE LINKS] > Click 
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[IMAGES] tab > Click the image that you loaded in the model > Click [PLACE INSTANCE] 

(CO 2) Adjust and verify the scale (CO 2) Adjust and verify the scale 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=92 

Confirm the scale and position of the imported drawings 

If the imported image/CAD file/PDF is in the right scale and position, skip this one, but double-check for your accuracy 

• [STEP 1] Select imported image > click [SCALE] from [MODIFY] tab, under [MODIFY] panel 
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• [STEP 2] Click the first point that you know the dimension. I will use the overall building dimension (58’-7”). You may 

also use a graphic scale if you have one 

You need to zoom in to select the first point in the middle of the dimension line. 

• [STEP 3] Click the second point 

• [STEP 4] Type the dimension [58’7”] and press [Enter] key 

• [STEP 5] Zoom out to see the position 
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• [STEP 6] Move the drawing to match the base drawing. You can use a specific point to match the drawing to the base 

Revit model that you created 

You may need to change the graphic display to [WIREFRAME] to see the image behind the model 
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Repeat this process for FLOOR PLAN – LEVEL 2, ELEVATION – EAST, WEST, NORTH, SOUTH 

(CO 3) Create and modify grids and levels (CO 3) Create and modify grids and levels 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=92 

Create grids 

• [STEP 1] Open [LEVEL 1] view 

• [STEP 2] Select [GRID] from [ARCHITECTURE] tab, under [DATUM] panel 

• [STEP 3] Using the straight-line selection, hover over the view near the west wall until it becomes highlighted in the 

center of the wall and an “X” appears 
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• [STEP 4] Click the first point and click the second point to complete the gridline 1 

• [STEP 5] To complete the remaining gridlines, you can copy or continue drawing gridlines based on the imported 

image 

• [STEP 6] To copy, select the Revit gridline 1 that you just made. Select the Copy tool and click a point and specify the 

second point to the next grid line 

• [STEP 7] Also you should use dimension [DI] to specify the distance between gridlines 

• [STEP 8] Continue to copy all North/South gridlines 

• [STEP 9] If the grid bubble and numbers are too big, you can update the view scale by clicking scale. For the Eames 

House project, use 3/8” = 1’-0” 
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• [STEP 10] Create a Horizontal new grid for East/West. And Update the Grid name to [A] and complete East/West grids 

• [STEP 11] Your gridlines and dimensions can be locked 

• [STEP 12] Open [NORTH] view and adjust the grid line heights by dragging and drop the edge of the grid line. And 

repeat this for [WEST] view 
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Create and Modify levels 

• [STEP 1] We will now make Levels. Begin by navigating to the [SOUTH] elevation in the Project Browser. 

◦ Adjust the length of the level by dragging and drop the edge of the level line 

◦ Repeat this for [EAST] elevation view 

• [STEP 2] After you have confirmed that Levels 1 & 2 are set to the correct elevation, you can add additional levels. To 

adjust the elevation number, click on the number and type in the correct elevation. 

Note: Level 2 will be [9’-7”] higher than Level 1. 

• [STEP 3] Add a roof level. 

◦ Select [LEVEL] from [ARCHITECTURE] tab, under [DATUM] panel 

Or, type [LL] 

◦ Click the left corner of the level and click the second point to finish the command 

◦ Rename [Roof] > Click OK in the window pop-up and change the view name accordingly 

◦ Adjust the height to [18′ 5 1/2″] 

• [STEP 4] If you copy (CO)the level from the existing level, the view will not be created. Create Ground and Level 1 top 

(Black symbol) 
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• [STEP 5] Update the view scales 

◦ 3/16” = 1’-0” for all elevations 

◦ 3/8” = 1’-0” for floor plans and ceiling plans 

(CO 4) Create plan views- Floors and ceilings (CO 4) Create plan views- Floors and ceilings 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=92 

Currently, you have what you need. When you add a new level [LL], the views automatically created. If you made the view 

by coping existing levels [CO], you have to create new views for the level 

• [STEP 1] Select [PLAN VIEWS] 

• [STEP 2] Select [FLOOR PLAN] if you need a floor plan 

• [STEP 3] Select [NAME OF THE LEVEL] and click [OK], then you can find the view from [PROJECT BROWSER] 
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If you need additional plans for furniture plans, power, and data plans, and finish plans, you need to duplicate the view by 

mouse-right clicking and select duplicate view > duplicate 

Note, there are three options for duplicating views. Please refer to this link for further explanation 

(CO 5) Create columns (CO 5) Create columns 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=92 

We will now add columns beginning on the Ground level 

• [STEP 1] Under the Architecture tab on the Ribbon select Structural Column. 

• [STEP 2] Select the 5” x 5” column. 

Note: an existing column family may need to be edited to create this size by clicking [EDIT TYPE] > Click 

[DUPLICATE] > add name [W5x 5] > click [OK] > update width and height to 5” 
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• [STEP 3] Confirm the Base Level is set to Ground and the Top Level is set to Roof 

• [STEP 4] Place a column on your [LEVEL 1] 

• [STEP 5] It will be necessary to Move [MV] and Copy [CO] the Revit columns to align as shown on the imported floor 

plan and the grid that you created 

Hide the imported drawing image to confirm all columns are properly placed 

Type [TL] to see the thick lines for print 
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SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 

  References References 

Autodesk.Help. (2007, September 13). About Duplicating Views in Revit. Retrieved October 22, 2020, from 

https://knowledge.autodesk.com/support/revit-products/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/3PP-
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Chapter 11. Add/edit beams, walls, & curtain 
walls 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Add/Edit Beam 

(CO 2) Create walls 

(CO 3) Edit walls wall properties – Wall thickness, Wall details, & Finishes 

(CO 4) Edit/add wall properties – Wall opening, wall sweep 

(CO 5) Add/Edit Curtainwalls, Mullions, & Panels 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Add/Edit Beam (CO 1) Add/Edit Beam 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=94 

Adding beams are not typical for interior design projects, but it is needed for the Eames House project. You may use this 

information for an open ceiling plan of commercial projects as well. 

You can find [BEAM] from the [STRUCTURE] tab, under the [STRUCTURE] panel. 

If you are missing the Structure tab, click [HOME] menu > Click [OPTION] > Click [USER INTERFACE] > Check 

[STRUCTURE TABL AND TOOLS] 

To see the structural element in solid shapes instead of lines, the view detail level must be [FINE]. Please update all floor 

plans, ceiling plans, and elevations to [FINE] on a detail level. 

Add Beams 

• [STEP 1] Click [Beam] on [Structure] 
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• [STEP 2] Select W Shapes-W5X5 

◦ If you don’t have a W5x5 type. Please add one by clicking Edit Type > Duplicate > Name the type > Edit Width and 

Height to 5 

• [STEP 3] Select [Level: Level 2] from Option Bar [Modify/Place Beam] for the West Wall of the building 

• [STEP 4] Click the center of the north column of the west wall, and click the center of the south column of the west 

wall. You will get a warning message, but it is OK, just click X 

• [STEP 5] Confirm the place from the 3D view by clicking the HOUSE icon from quick access and hide site 

information by category. Update the 3D view scale to 3/8”=1’-0.” 

• [STEP 6] Open the 3D view, West elevation, and the floor plan together by typing [WT] 
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• [STEP 7] The Beam must be rotated to 90 degrees. 

◦ Click the Beam, and change the properties 

◦ Change Cross-Section Rotation to 90 degree 

◦ The beam location needs to be aligned from the Top view of the 3D view. Use Move (MV) command to move the 

Beam to be aligned. 

• [STEP 8] See the West elevation and move the Beam to align with the imported image, [MOVE] command will not 

work. 

◦ Thus, update [Y OFFSET VALUE] to [1’ 1 ½”] 
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• [STEP 9] For other beams repeat step 1 through step 8. You may select all beams that you created and change the 

properties – Step 6 & 7. or Copy elements that have the same properties. 

◦ Complete beams for the second floor and the roof exterior beams, AND the second level interior beams 

Add NEW Beams from a new family 

• [STEP 1] Click [Load Family] on [Insert] tab 

• [STEP 2] Download [LH-Series Bar Joist.rfa] from Canvas Eames House module 

• [STEP 3] Find the folder and select the file and Open 

• [STEP 4] On Roof plan, Click [BEAM] on the [STRUCTURE] tab 

• [STEP 5] Click North column and South column to create the Bar Joist 
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• [STEP 6] Edit the family type to match the imported drawing 

• [STEP 7] Copy (CO) the first Bar Joist for the other Bar joists 
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(CO 2) Create walls (CO 2) Create walls 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=94 

Draw WALLs with Various types based on the imported base drawing image 

• [STEP 1] Select [WALL] from [ARCHITECTURE] tab, under [BUILD] panel 

or Type [WA] 

• [STEP 2] Select a Wall family 

◦ If you don’t have a wall type from the Properties, add by clicking Edit Type and Duplicate from a wall type. 

◦ For Eames House, we will use 

▪ Curtain Wall 1 

▪ Retaining -12” Concrete 

▪ Interior-4 7/8” Partition 

▪ Interior-6 1/8” Partition 

▪ Soffit-1/2” GWB & Metal Stud 

◦ But the wall details will be modified, and custom walls will be added later in this tutorial. 

• [STEP 3] Confirm [BASE CONSTRAINT] and [TOP CONSTANINT]. If needed set base offset and top offset 

• [STEP 4] Specify Location Line 

• [STEP 5] If the wall is other than a straight line, specify a line/shape type (circle, arc, rectangle, inscribed polygon, or 

ellipse. And draw lines to cross-reference of the imported base drawing image 

• [STEP 6] Make Dimensions [DI] for verification purposes. 

• [STEP 7] Confirm with 3D view 
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(CO 3) Edit walls wall properties – Wall thickness, Wall details, & Finishes (CO 3) Edit walls wall properties – Wall thickness, Wall details, & Finishes 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=94 

For your wall thickness, refer to Kilmer, W., & Kilmer, Rosemary. (2016). Construction drawings and details / W. Otie Kilmer 

and Rosemary Kilmer. (Third ed.). 

For your design project, you will need to decide on your construction details. 

Typical residential house wall thickness (For your reference) 

• Interior Wall (without Plumbing) = 4 ½” ((1) 2”X4” wood stud, which are 3 ½” deep + (2) ½” Gypsum boards) 

• Interior Wall (with Plumbing) = 6 ½” ((1) 2”X6” wood stud, which are 5 ½” deep + (2) ½” Gypsum boards) 

• Exterior Wall (with Brick) =  10” ((1) 2”X6” wood stud, which are 5 ½” deep + (1) ½” Gypsum boards + (1) ½” Insulation 

+ (1) 3 ½” Brick) 

• Exterior Wall (with Stucco, wood, aluminum, or vinyl) = 7 1/2”  ((1) 2”X6” wood stud, which are 5 ½” deep + (1) ½” 

Gypsum boards + (1) ½” Insulation + (1) 1” Stucco, wood, aluminum, or vinyl) 

For the Eames house project, although this building is residential, the construction is a combination of wood base and metal 

base. Revit provides walls for commercial construction, which is a metal base, so, you may use the provided walls and change 

some walls. 

• Interior Wall = Wood stud with Gypsum BD + Paint Finish or Wood BD (3 1/8”, 4 7/8”, 6”, 8”) 

• Exterior Wall = Curtain Wall with Glass, Wood, Metal panels 

• Exterior Wall = Metal with Gypsum BD + Paint Finish or Wood BD 

• Exterior Retain Wall = Concert 

Once you click a wall, you can edit the properties (wall height-where it starts and ends & wall phase) for each wall 

If you want to change the wall’s type (wall thickness Graphic style, materials, Structure, BIM information), you can change 

by clicking [Edit Type] 

For the future strategy, it is wise to [Duplicate] the type and edit type properties. For best practice, add “000” for the new 
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duplication. This will allow the types to organize in alphabetical order. 

Click [EDIT] on [STRUCTURE] and change thickness and material and click [OK] 

To change other walls from the Revit Metal base 4 7/8” wall to Wood base 4 ½.” 

• [STEP 1] Click one of Metal base 4 7/8” wall 

• [STEP 2] Mouse right click and click [Select all instances] and click [in Entire Project] 

• [STEP 3] Select [000_Interior-4 ½” Partition] 
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(CO 4) Edit/add wall properties – Wall opening, wall sweep (CO 4) Edit/add wall properties – Wall opening, wall sweep 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=94 

Wall opening or wall elevation modification 

• [STEP 1] On a plan view, click the wall that you want to make wall opening 

• [STEP 2] Click [Edit Profile] 

• [STEP 3] Go To View window will open. 

• [STEP 4] Select an appropriate view to open. I prefer the ISO view to quickly change the elements 
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• [STEP 5] Draw the opening with dimension 

• [STEP 6] Click the green checkmark to finish 

• [STEP 7] Double check in 3D view 

Wall Sweep is a very useful tool to create moldings 

• [STEP 1] To create a continuous molding. First, you need to load a profile by clicking [Load Family] from the [Insert] 

tab. 

• [STEP 2] Find Profile from Revit library and open it to the file. 
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• [STEP 3] Click the small arrow under Wall on Architecture tab 

• [STEP 4] Select Wall: Sweep on 3D view. Recommend a camera view or a 3D view with a section box 

• [STEP 5] Click [Edit Type] > Duplicate the type. Don’t forget to add “000” for your type. 

• [STEP 6] Click profile under construction, select the profile you just loaded. 

• [STEP 7] See the preview and click the appropriate location on the wall for the molding on the 3D view. 

• [STEP 8] To finish the Sweep, [ESC] on Keyboard. 

(CO 5) Add/Edit Curtainwalls, Mullions, & Panels (CO 5) Add/Edit Curtainwalls, Mullions, & Panels 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=94 

Modify curtain wall 

• [STEP 1] To add curtain wall grids, open a view. It can be an elevation view. You may close the floor plans. 

• [STEP 2] For the Eames house project, confirm the imported base drawing – elevations are in the correct locations. 
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• [STEP 3] Click [Curtain Grid] on [Architecture] tab 

• [STEP 4] Select [All Segments] or [One segment] 

• [STEP 5] Click grid lines and use dimensions for accurate distance based on the imported  elevations 

• [STEP 6] You can edit the grid, click the grid, and click add/remove segments. 

• Complete for all four exterior walls 

Add curtain wall mullion 

• [STEP 1] On the elevation, click [MULLION] on the [ARCHITECTURE] tab 

• [STEP 2] You may choose All Grid Lines, Grid Line, or Grid Line Segment 

• [STEP 3] Also, you may choose a specific type of Mullion by clicking Properties, and you can edit the type as well 

◦ You can change material, size, profile, the width of sides, angle, & offset 

• [STEP 4] Click lines to apply the mullion type that you selected 
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Modify Mullion 

• [STEP 1] If you need to change the mullion type, you can click the mullion that you made and change the properties 

• [STEP 2] If you need to change the mullion type and join order, click the Mullion you want to change and click [+] on 

the view to change the order 

To change the panel from Glazing to Solid, door, or window 

• [STEP 1] Select the panel to change by multiple [Tab] keys 

• [STEP 2] Change Properties to what you need 

• [STEP 3] If you need to change the properties, click [Edit type] and click [Duplicate] and change the value 

• [STEP 4] If you need to add a new type, Load family first and change the Properties 
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SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 12. Understand visibility settings, add/
edit floor & ceilings 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Understand View template, visibility graphics 

(CO 2) Understand View range 

(CO 3) Add/Edit Floors & Floor Properties 

(CO 4) Add/Edit Ceilings & Ceiling Properties 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Understand View template, visibility graphics (CO 1) Understand View template, visibility graphics 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=96 

[VIEW TEMPLATE] in Revit is a collection of view properties, such as a scale of a view, detail level, discipline, view ranges, 

orientations, model display, and visual settings. With using [VIEW TEMPLATE], you can apply standard settings to views. 

For example, I can make a Floor plan view template to apply all my floor plans. The floor plans will have the same scale, 

detail level, and style of lines. And you can also set a Furniture plan template. On the floor plans, you can hide all door tags 

and window tags at once. View templates save much time when producing a set of construction documents. 

To set a view template 

• [STEP 1] Click [VIEW TEMPLATE] from [PROPERTIES] palette, Assign view template window will open 

• [STEP 2] Select [ARCHITECTURAL PLAN] 

• [STEP 3] Click [DUPLICATE] icon, and Name it [3/8” Floor Plan] 

• [STEP 4] Update [VIEW SCALE] to [3/8”=1’-0”] 

• [STEP 5] Click [EDIT] on V/G Overrides Model, then Visibility/Graphic Overrides for 3/8” Floor Plan window will 

open 

• [STEP 6] You can hide categories that you don’t want to show in the view by unchecking the categories. 

• [STEP 7] Also, you and change the graphic styles by clicking [OVERRIDE] 

• [STEP 8] Click [OK]s to apply 
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To apply the view template to other views 

• [STEP 1] Select a view or multiple views 

• [STEP 2] Click [VIEW TEMPLATE] from [PROPERTIES] palette 

• [STEP 3] Select the view template you made for the selected views 

• [STEP 4] Click [OK] to apply 

Once you apply a view template, the visibility/graphic override, view scale, display model, detail level, view range, discipline, 

phase filter, and more items in the view templates will be deactivated on the view. To change the setting, you have to adjust 

in the view template, not individually. 

If you want to set the view settings individually, you must select [NONE] for the view template. 

For more information, please refer to this page for the view template. 

(CO 2) Understand View range (CO 2) Understand View range 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=96 

[VIEW RANGE] is a set of horizontal planes that control the visibility and display of objects in a plan view. 
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To adjust view range 

• [STEP 1] Click [VIEW RANGE] from [PROPERTIES] palette. If this is deactivated, check your view template and click 

[VIEW RANGE] from the template. 

• [STEP 2] You define the ranges by adjusting the offset value 

• [STEP 3] You can see the sample view range for better understanding by clicking [<< SHOW] button 

• [STEP 4] Click [OK] to apply 

For more information about [VIEW RANGE], please visit this page 

[UNDERLAY] is a function to understand the relationship of components at different levels for coordination and 

construction. 

To apply [UNDERLAY] 

• [STEP 1] Open the second-floor plan 

• [STEP 2] Click Range: Base Level and change the level that you want to look below 

• [STEP 3] Click Range: Top Level and change the level that you want to ‘lookup.’ 

• [STEP 4] For floor plans, the Underlay Orientation should be [LOOK DOWN] 

For RCPs, the Underlay Orientation should be [LOOK UP] 
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Once the underlay function is activated, you can see the gray lines. You are not able to click nor edit the underlay items. 

This function is only for the working process. If you don’t need the underlay items, please check [NONE] on Range: Base 

Level to deactivate the function. 

For more information about [VIEW RANGE], please visit this page. 

(CO 3) Add/Edit Floors & Floor Properties (CO 3) Add/Edit Floors & Floor Properties 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=96 

Revit is a BIM software; it needs more information to generate 3D views and Drawings. When in plan view the drawing 

appears complete much like it does in AutoCAD. However, when you view the Revit model in a 3D view, the floors and 

ceilings are missing. Therefore, you need to model these elements as well. 

There are multiple ways to create floors. I prefer to create a slab(without finishes) and then add finishes over the top of the 

slab. 
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To Add/Edit Floors 

• [STEP 1] Select [FLOOR ARCHITECTURAL] from [ARCHITECTURE] tab, under [BUILD] panel 

• [STEP 2] Select a Floor Type. For the First Level of Eames House, we will use [Generic – 12”], but we will modify the 

properties later. 

• [STEP 3] Select the level where the floor is located. And specify height offset from the level if required. 

• [STEP 4]Draw the boundary of the Floor plan. You can draw using straight lines or any of the other options. Make sure 

the boundary lines are connected and closed 

• [STEP 5] Click the green checkmark to complete the sketch 

• [STEP 6] Confirm the location on a section view or a 3D view 

You can click [SECTION] from the [VIEW] tab, under the [CREATE] panel. And draw a section line for verification 

purposes. 

Make sure your building pod must be below level 1. 
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Add a floor for the second level 

• [STEP 1] Open [LEVEL 2] floor plan 

• [STEP 2] Click [FLOOR] from [ARCHITECTURE] tab, under [BUILD] panel 

• [STEP 3] Change the floor type to 3” LW Concrete on 2” Metal Deck, and verify the Level 2, and the Offset 

• [STEP 4] Draw continued lines for the floor. If there are floor openings, draw the openings as well. If the openings are 

inside the boundary of the floor, Revit will recognize as it is opening. 

• [STEP 5] Click [GREEN CHECK MARK] to complete the sketches 
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Edit Floor properties 

You will change the thickness of the floor 12” to 2.” 

• [STEP 1] Select the first level floor from the 3D view 

• [STEP 2] Click [EDIT TYPE] on [PROPERTIES] palette 

• [STEP 3] Click [DUPLICATE] on [TYPE PROPERTIES] 

• [STEP 4] Enter a new name. I recommend adding [000_] of the letter of the name. 

For example [000_Generic – 2”] 

• [STEP 5] then click [OK] 

• [STEP 6] Click [EDIT] for [STRUCTURE] 

• [STEP 7] Change [2”] and click [OK] and [OK] to complete 

Add Floor types 

• [STEP 1] Click [FLOOR] from [ARCHITECTURE] tab, under [BUILD] panel 

• [STEP 2] Select [Generic – 12”] 

• [STEP 3] Click [EDIT TYPE] 

• [STEP 4] Click [DUPLICATE] 

• [STEP 5] Rename to [000_TL_01], you will need [000_TL_02], and [000_CPT_01] 
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• [STEP 4] Click [EDIT] for [STRUCTURE] 

• [STEP 5] Change the Function to [FINISH 1] 

• [STEP 6] Change the Thickness to [1/2”] 

• [STEP 7] Click <By Category> 

• [STEP 8] Click [CREATE A NEW MATERIAL] 

• [STEP 9] Rename the new material 

• [STEP 10] Check [USE RENDER APPEARANCE] 

• [STEP 11] Change the foreground pattern 

• [STEP 12] Click [APPEARANCE] tab 

• [STEP 13] Click [REPLACE THIS ASSET] 

• [STEP 14] Find appropriate material from [APPEARANCE LIBRARY] 

• [STEP 15] Click the [REPLACE] icon, and close the [ASSET BROWSER] 

• [STEP 16] If needed, change the color 

• [STEP 17] Click [OK]s to complete 

Add floors for finishes 

• [STEP 1] Open a plan view to add the finish floor 

• [STEP 2] Confirm the level on the [PROPERTIES] 

• [STEP 3] Change the Height Offset From Level to [1/2”] 

• [STEP 4] Draw Floor Boundary, please consider not to overleap with walls 
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(CO 4) Add/Edit Ceilings & Ceiling Properties (CO 4) Add/Edit Ceilings & Ceiling Properties 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=96 

Add a ceiling 

• [STEP 1] Open [LEVEL 1] ceiling plan 

• [STEP 2] Click [CEILING] from [ARCHITECTURE] tab, under [BUILD] panel 

• [STEP 3] Select [GWB on Mtl. Stud] 

• [STEP 4] Confirm [LEVEL] is [LEVEL 1 CEILING] and [HEIGHT OFFSET FROM LEVEL] to [0’0”]. 

If you don’t have a level for a ceiling, you can set your level to Level 1 and update the height offset from a level like 

8’-0.” 

• [STEP 5] Draw the Ceiling boundary. 

You will need to draw an independent ceiling for each room. 

• [STEP 6] Click the green checkmark to complete this command. 
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• Repeat this process to place a ceiling at level 2 

Edit Ceiling properties 

You will change the thickness of the ceiling 12” to 2.” 

• [STEP 1] Select the first level ceiling from the 3D view 

• [STEP 2] Click [EDIT TYPE] on [PROPERTIES] palette 

• [STEP 3] Click [DUPLICATE] on [TYPE PROPERTIES] 

• [STEP 4] Enter a new name. I recommend adding [000_] of the letter of the name. 

For example, [000_GWB on Mtl.Stud-3”] 

• [STEP 5] then click [OK][STEP 6] Click [EDIT] for [STRUCTURE] 

• [STEP 7] Change [2 3/8”] for [METAL STUD LAYER] and click [OK] and [OK] to complete 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 13. Add/edit stairs, rails, & roof 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Add/Edit Stair – three types of staircases 

(CO 2) Add/Edit Railing 

(CO 3) Add/Edit Roof 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Add/Edit Stair – three types of staircases (CO 1) Add/Edit Stair – three types of staircases 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=98 

• Revit provides various types of staircases, and it is modifiable. 

• Revit stair automatically calculates the number of stair runs, automatically creating landing, supports, and even 

handrails. 

• In this tutorial, the instructor will demonstrate four types of staircases – a straight stair, two runs (a switchback stair), a 

spiral, and a custom with sketch in another Revit file only for reference. 

• For the Eames house, students will only need a spiral staircase. 

• For more information about Revit stairs, please visit this page 

To create a straight stair 

Be aware of the overall size of the staircase and create walls for the staircase before you create a staircase in Revit. If it is an 

open staircase, please use the reference plane for a guideline. 

• [STEP 1] Open floor plan views (e.g., Level 1 floor plan view and Level 2 floor plan view) and 3D view or a section 

view with a perspective view to see the height and overall shape of the staircase. And view change to Window Tile view 

(WT) 

• [STEP 2] Draw Detail Line (DL) for the outlines of the staircase. You may turn on the CAD drawing that you already 

imported. 

• [STEP 3] Click [STAIR] from [ARCHITECTURE] tab, under [BUILD] panel 

• [STEP 4] Select [STRAIGHT] from [MODIFY/CREATE STAIR], under [COMPONENT] panel 
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• [STEP 5] Select a center point for the stair start point on a plan view, then Revit automatically calculates and shows 

how many stairs are needed to reach the next floor. Then, click the endpoint on the current view to finish 

• [STEP 6] Then, the preview will show on all the views. If it looks OK, click the green checkmark to finish. If it needs 

changes, the types of family, click family type on [PROPERTIES] palette, and select the desired family. If you do not 

have a desired family for the stair, load the family first 

• [STEP 7] If the stair run width need a modification, click the run, then change the width by adjusting the arrows 

If the stair Riser Height or/and Tread Depth change, click [EDIT TYPE] and change the Type Properties. Do not forget, 

if you change the type properties, all types will change. To prevent this, please [DUPLICATE] and edit. 

• [STEP 8] Click [GREEN CHECKMARK] to complete 

• [STEP 9] Remove the Detail lines or the Reference Plans that you used for the stair 

• [STEP 10] If you found errors on your stair, click [EDIT STAIRS] to fix the error 
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To create a two-runs stair (a switchback stair) 

• [STEP 1] Open floor plan views (e.g., Level 1 floor plan view and Level 2 floor plan view) and 3D view or a section 

view with a perspective view to see the height and overall shape of the staircase. And view change to Window Tile view 

(WT) 

• [STEP 2] Draw Detail Line (DL) for the outlines of the staircase. You may turn on the CAD drawing you already 

imported. 

• [STEP 3] Click [STAIR] from [ARCHITECTURE] tab, under [BUILD] panel 

• [STEP 4] Select [STRAIGHT] from [MODIFY/CREATE STAIR], under [COMPONENT] panel 

• [STEP 5] Select a center point for the stair start point on a plan view, then Revit automatically calculates and shows 

how many stairs are needed to reach the next floor. Then, click the second point on the current view to create the 

landing start 

Then, click the third point on the current view to create the second stair start point 

Then, click the endpoint on the current view to finish 

• [STEP 6] Then, the preview will show in all the views. If it looks OK, click the green checkmark to finish. If it needs 

changes, the types of family, click family type on [Properties] palette, and select a desire family. If you do not have a 

desire family for the stair, load the family first 
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• [STEP 7] If the stair run width needs a modification, click the run, then change the width by adjusting the arrows 

• [STEP 8] Click [GREEN CHECKMARK] to complete 

• [STEP 9] Remove the Detail lines or the Reference Plans that you used for the stair 

To create a spiral stair 

• [STEP 1] Open floor plan views (e.g., Level 1 floor plan view and Level 2 floor plan view) and 3D view or a section 

views with a perspective views to see the height and overall shape of the staircase. And view change to Window Tile 

view (WT) 

• [STEP 2] Draw Detail Line (DL) for the outlines of the staircase. You may turn on the CAD drawing you already 

imported. 
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• [STEP 3] Click [STAIR] from [ARCHITECTURE] tab, under [BUILD] panel 

• [STEP 4] Select [FULL STEP SPIRAL] from [MODIFY/CREATE STAIR], under [COMPONENT] panel 

• [STEP 5] Select a center point of the staircase start point on a plan view, then Revit automatically calculates and shows 

how many stairs are needed to reach the next floor. Then, click the center point of the run start on the current view to 

create the staircase. 

• [STEP 6] Then, the preview will show on all the views. If it looks OK, click the green checkmark to finish. If needs 

changes, the types of family, click family type on [PROPERTIES] palette and select a desired family. If you do not have 

a desired family for the stair, load the family first 

• [STEP 7] If the stair run width needs a modification, click the run, then change the width by adjusting the arrows 
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• [STEP 8] Click [GREEN CHECKMARK] to complete 

• [STEP 9] Remove the Detail lines or the Reference Plans that used for the stair 

Complete the staircase for the Eames house project with [FULL STEP SPIRAL] tool. It may need some adjustment because 
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of the structure and shape. Please experiment for the staircase. 

To create a custom stair 

• [STEP 1] Open floor plan views (e.g., Level 1 floor plan view and Level 2 floor plan view) and 3D view or a section 

view with a perspective view to see the height and overall shape of the staircase. And view change to Window Tile view 

(WT) 

• [STEP 2] Draw [BOUNDARY] 
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• [STEP 3] Draw [RISER] 

• [STEP 4] Draw [STAIR PATH] 
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• [STEP 5] Click [GREEN CHECKMARK] to finish 

• [STEP 6] If needed, click [FLIP] the direction of the staircase 
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• [STEP 7] Click [GREEN CHECKMARK] to complete the tool 

Autodesk provides sample stairs and railings. Please download the samples by clicking this page and copy and paste that 

which you want to use in your project. This process will load the family files to your Revit file 
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(CO 2) Add/Edit Railing (CO 2) Add/Edit Railing 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=98 

Typically, railings are automatically created when a staircase is made 

For more information about Railings, please read this page 

However, many times, your railings need modifications. 

To extend your railings 

• [STEP 1] click the railing 

• [STEP 2] click [EDIT PATH] 

• [STEP 3] edit/add the path 

To edit handrail 

• [STEP 1] If a Handrail path needs changing, you can select handrail only by pressing the [TAB] key 

• [STEP 2] click [EDIT RAIL] 

• [STEP 3] click [EDIT PATH] it would be better to work in Section or a 3d view 
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To change the handrail type, change the family type from [PROPERTIES] palette 

To create a path without a stair 

• [STEP 1] Click [RAILING] 

• [STEP 2] Click [SKETCH PATH] 

• [STEP 3] Sketch a path with a drawing tool on a plan view 

• [STEP 4] Click [GREEN CHECKMARK] to finish 
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(CO 3) Add/Edit Roof (CO 3) Add/Edit Roof 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=98 

In this session, I will demonstrate the two types of roof; one is the Eames house roof – Flat roof and a typical residential roof 

– Hip roof 

There are ten standard roof shape models in the Revit tutorial. Please watch this tutorial for your other projects 

10 Common Roof Shapes Modeled in Revit Tutorial 

Please find Autodesk provided roof tutorials from this link 

If you want to create complex roof shapes in Revit, please watch this YouTube video 

3 Complex Roof Shapes in Revit 

For the Eames House project, you will create two models, which are the roof on the top of the metal deck and the Edge of 

the roof. 

Add a flat roof 

• [STEP 1] From the Project Browser, switch to the Roof plan. 

• [STEP 2] In the Properties, with nothing selected, set the Underlay to level 2. 

• [STEP 3] From the Architectural tab, click the small arrow on the roof] > Click [ROOF BY FOOTPRINT] 

• [STEP 4] Use the Draw tool to create a boundary. 

◦ Make sure you check Basic Roof – Generic – 9” > Duplicate – 3.” 

◦ Base level – Roof 

◦ Base offset from level – 0’ 0.” 

◦ Uncheck – Defines slope 

◦ Offset – 0’ 0.” 

• [STEP 5] Once the boundary line is done, click the green checkmark 

• [STEP 6] Your roof will be over the Metal deck; you can move the roof above the metal deck 
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• [STEP 7] You may add a point / a line for slope for a roof drain, click [ADD POINT] and click a point on the roof and 

change the height. 

To create a gutter 

• [STEP 1] From the Architectural tab, click the small arrow on the roof] > Click [ROOF: GUTTER] 

• [STEP 2] Default will be Gutter – Bevel 5” x 5”. We will change to 6”x 6.” 

• [STEP 3] Click [EDIT TYPE] > [DUPLICATE] > name change [000_Gutter – Bevel 6″ x 6″] > Click [OK] 

• [STEP 4] Click Gutter Profile-Bevel: 5”x5” on profile 

• [STEP 5] Change to 6”x 6” > Click [OK] 

• [STEP 6] From the ISO view, click the top edges of the roof 

• [STEP 7] To finish, [ESC] key 
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Add a hip roof (combined) 

• [STEP 1] From the Project Browser, switch to the Roof plan. 

• [STEP 2] In the Properties, with nothing selected, set the Underlay to level 2 or level 1. 

• [STEP 3] From the Architectural tab, click the small arrow on the roof] > Click [ROOF BY FOOTPRINT] 

• [STEP 4] Use the Draw tool to create a boundary. 

◦ Make sure you check Basic Roof – Generic – 9” > Duplicate – 3.” 

◦ Base level – Roof 

◦ Base offset from level – 0’ 0.” 

◦ Check – Defines slope 

◦ Slope – 9”/12.” 

◦ Offset – 1’ 6.” 

• [STEP 5] Select 3 lines do not have a slope, uncheck [DEFINES SLOPE] 

• [STEP 6] Click [GREEN CHECKMARK] when it is done 

• [STEP 7] From the Architectural tab, click the small arrow on the roof > Click [ROOF BY EXTENSION] 

• [STEP 8] Revit will ask you to select a work plan > Select [PICK A PLANE] > Pick a face of wall where the roof profile 
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will start 

• [STEP 9] Revit will ask you to select Roof reference level and offset > Click [OK] 

• [STEP 10] Draw a continued open line for the roof on a Front view 

• [STEP 11] Click Green checkmark when it is done 

• [STEP 12] On the plan view, you will adjust the depth of the roof 

• [STEP 13] To fix the separated roof, you may use [ JOIN/UNJOIN ROOF] on the Modify tab 

• [STEP 14] Click the profile first and click the face where the profile will meet 

• [STEP 15] To meet all wall to the Roof, Select all walls 

• [STEP 16] Click [ATTACH TOP/BASE] 

• [STEP 17] Click the roof, you may get a warning, but it is OK. 
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SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 14. Add/edit windows, doors, lighting 
fixtures, furniture, tags, & sheets 

Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Understand the concept of family file 

(CO 2) Add/Edit Doors and Windows 

(CO 3) Add Tags 

(CO 4) Add/Edit Lighting fixtures 

(CO 5) Add/Edit Titleblocks 

(CO 6) Insert Plan views and symbols – North arrow and graphic scale 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Understand the concept of family file (CO 1) Understand the concept of family file 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=100 

About Revit Families 

• A Revit family is a group of elements with a common set of properties, called parameters, and a related graphical 

representation 

• All of the elements that you add to your Revit projects are created with families. 

• For example, the structural members, walls, roofs, windows, and doors that you use to assemble a building model, as 

well as the callouts, fixtures, tags, and detail components that you use to document it, are all created with families. 

For more information about the Revit family, please see this page Autodesk Knowledge – Revit Family 

To create a new family 

• Click [File] on the menu > Click [New] > Click [Family] > Select a template from library > create the model and 

parameter 

• However, A beginner may elect to not create a new family due to the complexity of the process. Instead, you may want 

to start with a family that has similar attributes and edit accordingly. 
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To load Family files from the Revit library 

• Click [Load Family] from [Insert] tab, under [Load from Library] panel > Find the library folder from your computer > 

Select a family / families to load > Click [OPEN] 

• Then, you can confirm and find the loaded families from the [Project Browser] under the [Family] category 

• You can load as many families as possible but you should consider file size. 

Find and download Revit families from external sources (recommended websites by the instructor) 

• BimObject https://www.bimobject.com/en-us 

◦ Manufacturer upload Revit Family files 

◦ Previously named Autodesk Seek 

◦ Most of the files are reliable, some advertisements added 

• Revit City https://www.revitcity.com/index.php 

◦ The user shared Revit Family website 

◦ Many designers, practitioners, and students use this website 

◦ Some files may cause issues to your project 

• BIM Smith https://market.bimsmith.com/ 

◦ Mix of free and paid Revit Families 

◦ Great collection of products 

• NBS National BIM Library https://www.nationalbimlibrary.com/en/ 

◦ UK based the best BIM object website 

◦ Manufacturers website 

◦ Most reliable but hard to find out 
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Purge Revit families 

• Family management is one of the keys to managing your Revit file. If you want to delete unused family files, click 

[Purge Unused] from the Manage tab. 

• Use caution when using this function; you will lose all family and views you are not using. I recommend you make a 

copy or save as the original file and [Purge Unused]. 

• Click [Purge Unused] Number of items checked until “0”. 

• The file size reduced, then you have a lighter file to handle 

(CO 2) Add/Edit Doors and Windows (CO 2) Add/Edit Doors and Windows 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=100 

Add a door on a Wall 

• [STEP 1] Click [Door] from the [Architecture] tab, under [Built] panel 

or press [DR] as a shortcut 

• [STEP 2] Select door type from the [Properties] palette. 

◦ If you need to load a new type, click the [Modify/Place Door] tab and click  [Load Family], Double click [Doors] 

Folder, find out the family that you want from the sub-folders 

◦ If you cannot find the door family that you want, you may search on various websites above and load into the 

project file 
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◦ If you found the type you want, but you do not find the size of the door, you click [Edit Type] and Duplicate the 

type and change the values 

• [STEP 3] Place the door near the wall. Use [Space bar] to change the direction of the door. It shows the location of the 

door that will be placed. Click the location that you want. 

• [STEP 4] Once you placed the door, you can change the direction by clicking arrows, and you can change the exact 

location of the door. Typically, the distance between the wall to the door is 4.” 

• [STEP 5] If you need to change the door type, click and change the type from the Properties panel 

Complete to add all doors in the floor plans for the project 

Add a window on a wall 

• [STEP 1] Click [Window] from the [Architecture] tab, under [Build] panel 

or, press [WN] as a shortcut 

• [STEP 2] Select a window type from the [Properties] palette. 

• [STEP 3] Adding a window is the same sequence as adding a door. 

• [STEP 4] You can modify the sill height when you add a window. 

The Eames House project doesn’t have a window. 

Add a skylight on a roof 

• [STEP 1] Click [Window] from the [Architecture] tab 

or press [WN] as a shortcut 

• [STEP 2] If you do not find a skylight from the [Properties] palette, click [Load family] > find the Skylight family under 

the Window folder from the Revit library > click [Open] 
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• [STEP 3] The Skylight for Eames House is 5’X5’ Flat, so the type should be made by duplicating the existing one. 

• [STEP 4] Open [3D view] > click the appropriate location where the skylight is supposed to be located > open [Roof] 

view > update location of the skylight with dimensions 

• [STEP 5] You may notice that the skylight only opens the roof, not the ceilings you may make. You must make a hole to 

open the ceilings. Click [Shaft] from the [Architecture] tab, under [Openning] panel > Open the plan below the roof 

level. For Eames house, it is Level 2 > Draw the opening. It must be a little smaller than the skylight size and click the 

[green checkmark] 

• [STEP 6] Make sure the base constraint is Level 2, and the Top constraint is Up to Level: Roof, Top Offset 1’. Relocate 

the Skylight. 
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Note. If [Shaft] tool is not working, please try this 

• Click [Edit In-Place] > Click [Void Forms] > Select [Void Extrusion] from [Create] tab > Draw lines > click the [Green 

checkmark] to finish and double-check the void penetrate 

Add a door / a window on a curtain wall 

• [STEP 1] Adding a curtain wall door or window is not under the Door or Window from the [Architecture] tab. To 

switch a panel to a door or a window, you must select the panel first by pressing the [Tab] key. 

• [STEP 2] You might find the door from the [Properties] palette. 

◦ If the curtain wall door was not loaded, you need to load the door first and then change the properties palette. 

◦ To load the door family, click [Load Family] from the [Insert] tab 

◦ Find “Door-Curtain-Wall-Single-Glass.rfa” from the Doors folder > Open 

◦ Find “Curtain Wall-Awning.rfa” from the Windows folder > Open 

◦ Find “Sliding_Curtain_Wall_Door_12253.rfa” from Canvas and download to your project folder > Open 

• [STEP 3] Change the type from the properties palette. 
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Complete to update all curtainwall doors and curtainwall windows for the project 

(CO 3) Add Tags (CO 3) Add Tags 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=100 

Add door and window tags 

• [STEP 1] Click [Tag by Category] from the [Annotate] tab, under [Tag] panel 

or (TG) for the shortcut 

• [STEP 2] The Door tag setting can be made a distance (1/4”) from the door 

• [STEP 3] Once you click a door, the tag will show 

• [STEP 4] The number may show or may not show. If not, you can make a number 

• [STEP 5] You can also tag both the curtain wall door and windows with a door and window tag. 
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Complete to update all tags for doors and windows for the project 

(CO 4) Add/Edit Lighting fixtures (CO 4) Add/Edit Lighting fixtures 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=100 

Load Lighting Fixtures 

Load Lighting families by clicking Load Family. You can find Revit lighting families from Lighting > Architectural > Internal 

folder from the Revit library. You can load all lighting fixtures from the folder or only selected lighting fixtures to your 

project. 

If you want a unique lighting fixture, please download it from various websites and save it in your project folder for future 

use. 

Add Lighting fixtures 

• [STEP 1] Open [Level 1] Ceiling plan from the [Project Browser] 

• [STEP 2] Click [Component] (CM) to place lighting fixtures from the [Architecture] tab 

• [STEP 3] Select a family and a family type that you want to add on your ceiling plan. You can search the Lighting family 

as well 

• [STEP 4] Select [Downlight – Recessed Can] 

• [STEP 5] Place the lighting fixture on the Utility room ceiling. You may need to switch the placement option. Does not 
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need to be accurate. 

• [STEP 6] Make dimensions (DM) and use Align (AL) for the accurate dimension 

To see the floor plan for the positioning of the furniture, Select Level 1 for Base Level, Leve 2 for Top-level, “lookup” 

for Underlay orientation, and then you can see the floor plan on your ceiling plan for lighting layout. 

Complete lighting layout with dimensions on the ceiling plans 

(CO 5) Add/Edit Titleblocks (CO 5) Add/Edit Titleblocks 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=100 

Create sheets 

• [STEP 1] Click [Sheet] from the [view] tab, under [Sheet Composition] panel 

• [STEP 2] New Sheet window will pop up to create sheets in your project. Click [Load…]. 

• [STEP 3] The load Family browser will pop up. Find [Titleblocks] folder > Open [B 11 x 17 Horizontal] file > click [OK] 

> Click [OK] to load on your project file. 

• [STEP 4] You can find your A101 – Unnamed on your project browser, once you click [+] mark next to [sheet (all)] 
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• [STEP 5] If you need more sheets for other views, you can click sheet] from the [View] tab, or you can click the Sheets 

on Project Browser, and mouse right-click and select New Sheets 

• [STEP 6] If you want to change the size of the sheet you already loaded, you can click the title block and change the 

type on the Properties palette. You can change the Titleblock format that you already loaded 

• [STEP 7] On your Titleblock, you should add the project information and the sheet information. 
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◦ Once you click the Titleblock, you can add more information. Do not double click. If you double click and open 

the family file, you are editing the family file. 

◦ Under the Owner, we would typically designate the client’s name. In this case, you can add ARTID263 

◦ For Project Name, you can add your project name, Eames House Project 

◦ For Unnamed, it typically designated for the Sheet name, for example, Floor Plan – Level 1, RCP – Level 2, Site 

Plan, or more 

◦ For Project number, you will make your own. I typically make 20.263.01 (Year.Course number.Project number) 

◦ The issue date will be the submission date 

◦ The author is your name 

◦ Checker is your instructor’s name 

Note. This Sheet information will not change even if you change the Titleblock type. And the Project name, Project number, 

Client, and Issue date will not change even if you add new sheets. But you should add Drawn by and Checked by for all 

sheets 

Edit Titleblocks family file 

• [STEP 1] Once you double click the Titleblock, the family file will open 

• [STEP 2] I recommend saving this family before you start to edit to preserve the original file. 

◦ Do not forget to add “000” and save the file in your project family folder 

• [STEP 3] You can delete anything in the document. However, I would delete the Autodesk Logo, a line below, and the 

website information. 

• [STEP 4] You can add lines by clicking [Line] from the [Create] tab 

• [STEP 5] You can move lines and text box by clicking the elements that you want to move and move (MO) command 

• [STEP 6] You can edit lines and text box size as well 

• [STEP 7] You can insert images or CAD files by clicking Image or Import CAD   from the Insert tab 

• [STEP 8] Once you complete your titleblock, you must save and click [Load into Project] 

• [STEP 9] After you load the titleblock into your project, you must change the titleblock type to what you made. 
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(CO 6) Insert Plan views and symbols – North arrow and graphic scale (CO 6) Insert Plan views and symbols – North arrow and graphic scale 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=100 

Insert plans 

• [STEP 1] Open a sheet [A101-Floor Plan-Level 1] to insert a plan 

• [STEP 2] Find the view on your project browser to insert, drag and drop the view to the sheet 

• [STEP 3] To fit into the Titleblock, you must change your drawing scale. You can double click and change the scale, or 

you can change the scale from the Properties palette 
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• [STEP 4] Move the view to be centered and change the length of the title bar to fit into the Titleblocks 

Repeat this for site plan, floor plans, and ceiling plans 

Insert north arrow 

• [STEP 1] The north arrow is under Symbol from the [Annotate] tab 

• [STEP 2] To add the north arrow, you will open a plan view 

• [STEP 3] On the Properties palette, Orientation should be changed from Project North to True North 
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• [STEP 4] Click Symbol from Annotate tab 

• [STEP 5] Select North Arrow 2 on the Properties palette. If you cannot find North Arrow 2, you need to load the 

North Arrow family from the Annotation folder 

• [STEP 6] Place the North Arrow 2 on your plan view 

• [STEP 7] Change Orientation again from Ture North to Project North 

• [STEP 8] Move the north arrow to the corner of your plan 

Repeat this for site plan, floor plans, and ceiling plans 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 15. Add/edit model-in-place 
components & edit family 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Add/Edit Furniture families 

(CO 2) Add/Edit Model-in-place components – Custom casework 

(CO 3) Add/Edit a New Family – Furniture 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Add/Edit Furniture families (CO 1) Add/Edit Furniture families 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=102 

For construction documents in Revit, furniture can be mainly categorized into two main areas. One is a product, which 

includes custom furniture and manufacture-made furniture, and the other is a contractor (carpenter) made built-in furniture 

or millwork. 

• We typically use [PLACE COMPONENTS] a Revit family for custom furniture and manufacture-made furniture 

because it will be used multiple times. It includes millwork like Revit Countertop, Shelf, Cabinets, and so on. 

• We typically use [MODEL-IN-PLACE] for contractor made built-in furniture or millwork because it will be used only 

once for the specific space only. 

Revit Furniture [PLACE COMPONENTS] 

• [STEP 1] Open a Floor Plan – Level 1 view from Project Browser 

• [STEP 2] You may change the scale of the view because we changed the drawing scale to fit on an 11in X 17 in sheet. I 

changed the drawing scale from 3/32” to 3/16” 

• [STEP 3] Click [COMPONENTS] (CM) from [ARCHITECTURE] tab 

• [STEP 4] You will find furniture (or any components-lighting fixture, plumbing, case work-sink, appliances, plants) 

from [Properties] palette that you want to put in the floor plan. If you do not find the furniture from the panel, you 

must click [LOAD FAMILY] from the [MODIFY/PLACE COMPONENT] tab and find the furniture family you want 
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to add from the Library folder or the websites from Session 14 

◦ BimObject https://www.bimobject.com/en-us 

◦ Revit City https://www.revitcity.com/index.php 

◦ BIM Smith https://market.bimsmith.com/ 

◦ NBS National BIM Library https://www.nationalbimlibrary.com/en/ 

◦ Manufacturers’ website 

TIPS. 

For your Floor plan, you do not need to find the exact furniture that you want to use. You may use the Revit furniture family 

for your floor plan as a placeholder. Do not waste time to add all objects (like books, decorative pieces for perspectives) that 

are not showing on your floor plan. For your perspective views and renderings, it would be better to find the most accurate 

Revit family file. If you cannot find the Revit family file, find the SketchUp file and use it for your rendering. 

• [STEP 5] Place the furniture families on your floor plan. Make sure the Level is what you want. 

• [STEP 6] Use [Space bar] on your keyboard to rotate the family. 

To move/rotate/align/copy/mirror the furniture, click the furniture that you want to move/rotate and then click 

[MOVE] (MO), [ROTATE] (RO), [align] (AL), [COPY] (CO), or [MIRROR] (MM) from [MODIFY/FURNITURE] tab 

• [STEP 7] Also, you can use [ALIGNED DIMENSION] (DI) from the [ANNOTATION] tab 

• Complete all furniture placement 
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(CO 2) Add/Edit Model-in-place components – Custom casework (CO 2) Add/Edit Model-in-place components – Custom casework 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=102 

Create Model in Place components (Alcove seating) 

• [STEP 1] Open a Floor Plan – Level 1 view from Project Browser 

• [STEP 2] You may turn on the reference CAD plan/Imported image to see the size of the Alcove setting or turn on 

[HIDDEN ELEMENTS] if it is hidden and unhide the category 
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• [STEP 3] Click Component small black arrow and click [MODEL IN PLACE] from [ARCHITECTURE] tab 

• [STEP 4] You will need to select the most relevant Family Category. For the Alcove Seating, [CASEWORK] is the most 

appropriate category. Click [OK] 

• [STEP 5] make a name for the component [Alcove seating]. 

• [STEP 6] To draw lines/models, you must set/confirm the [WORK PLANE] first 

◦ Click [SET] from [CREATE] tab 

◦ You can select the work plane with the name or pick a plan. Make sure this will be the base plane that you work 

• [STEP 6] You can make models with the Forms tool 

◦ For the alcove seating, click [EXTRUSION] and draw lines with the [DRAW] tool 

◦ The line must be closed. You may use [TRIM] (TR) to make it closed 

◦ Double-check the Extrusion End and Extrusion Start 

◦ Click the [GREEN CHECKMARK] to finish the drawing 
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◦ For the upper part, you will create the upper part in the current [MODEL-IN PLACE COMPONENT] 

◦ If you want to try other Forms, you are welcome to try and practice. 

◦ Use the [VOID] tool and Cut tool to subtract a form from other forms (s) 

◦ Click Extrusion > Draw lines > make sure the extrusion End and Start > Click [GREEN CHECKMARK] 

◦ If the model is not showing, please check on your ISO view and change the [WORK PLANE] 

◦ Once all forms created, you will click the [GREEN CHECKMARK] to Finish Model 

• Complete the casework 
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(CO 3) Add/Edit a New Family – Furniture (CO 3) Add/Edit a New Family – Furniture 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=102 

In this tutorial, I will demonstrate how to create a simple furniture family in Revit. We will use Eames Walnut Stool 

information from https://www.hermanmiller.com/products/seating/stools/eames-walnut-stools/ 

To create a new family file (Model it will be used multiple times) 

• [STEP 1] Click [FILE] > [NEW] > [FAMILY] 

• [STEP 2] Find [Furniture.rft] in the Select Template File browser and Click [OPEN] 
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• [STEP 3] It will automatically open these four windows. Before you start, save the family file to your project folder. 

• [STEP 4] I recommend you make the view tile (WT) and Zoom All (ZA) see all views. You will pick a view 

[REFERENCE LEVEL], or [FRONT] view depends on what you want to make. 

• [STEP 5] To draw the stool, you will use [REVOLVE] to draw this stool 

• [STEP 6] Before you draw a revolving line, you will need [REFERENCE PLANES] to know the Height and Width. 

Click [REFERENCE PLANE] from the [CREATE] tab 

• [STEP 7] Draw height left, and right reference plane and dimension it 

Dimension information from this page 
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• [STEP 8] On [FRONT] view, Click [REVOLVE] from the [CREATE] tab 

• [STEP 9] Draw lines for the Profile (Boundary). The lines are to be closed 

• [STEP 10] Select [AXIS LINE] and pick the centerline 

• [STEP 11] Click the [GREEN CHECKMARK] to finish the model 
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• [STEP 12] If you want to add/subtract any model, you can create it in this model 

• [STEP 13] Once all your model works are done, save the family file on your project folder. 

• [STEP 14] Click [LOAD INTO PROJECT] to your project. 

Note. Use Sketchup Model in Revit 

Importing SketchUp Files into Revit Tutorial 

If you want your Sketchup file in multiple-use, you should make it as a family file. 

Sketchup material will not be followed and merged as one material, but I will demonstrate some tips in the next session. 

Refer to this video 

Revit Architecture | Convert SketchUp Models Into Revit(With Materials) 
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SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 16. Add/edit elevation, section, detail, 
text, annotation, & rooms 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Add/Edit Elevations & Sections – Adjust crop region 

(CO 2) Add/Edit Detail views 

(CO 3) Add Texts & Annotations 

(CO 4) Add/Edit Rooms, Room tags, Room separators 

(CO 5) Add/Edit a color fill scheme 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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Lecture Contents Lecture Contents 

(CO 1) Add/Edit Elevations & Sections – Adjust crop region (CO 1) Add/Edit Elevations & Sections – Adjust crop region 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=104 

You can create sections or elevations in any floor plans. 

To add an interior elevation 

• [STEP 1] Open the project, and open [Level 1] floor plan 

• [STEP 2] Click [Elevation] from [View] tab, under [Create] panel 

• [STEP 3] Click the [Properties] palette > select Interior Elevation, the symbol will be updated. 

• [STEP 4] Hover over your plan. You will notice the elevation marker will “snap” parallel to walls. Please select the 

location where you want to place your elevation and click to set it in place. Press [Esc] to complete the command 

• [STEP 5] Select the elevation tag. You can create additional elevations from one elevation symbol. Press [Esc] to 

complete the command 

• [STEP 6] Select the elevation arrow (black filled) to adjust the crop region and view depth by moving the blue line; you 

can adjust where the elevation view begins. By adjusting the blue nodes on the line, you can define the crop region. 

Moreover, by moving the arrows, you can adjust the view depth of the elevation. 

Revit Session 9  |  228

https://iastate.pressbooks.pub/visualgraphiccomm/?p=104#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=104#pb-interactive-content


• [STEP 7] Once your elevation is defined, double click on the arrow of the elevation symbol > the newly created 

elevation view will be open. You may realize the current view is not what you want to present. If the view shows right, 

please skip [STEP 8] and  [STEP 9] 

• [STEP 8]Click the edge of the elevation > click [Edit Crop] 

• [STEP 9] Redraw the boundary of the elevation. The boundary must be a closed-loop > Click [Green check-mark] to 

finish the crop boundary. 
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• [STEP 10] Make sure you check all three [Crop view], [Crop Region Visible], and [Annotation Crop] on [Properties] 

palette. 

Note. The solid blue defines the visible region, and the dashed line defines where your annotations can be viewed and 

placed. Additionally, you can continue to adjust their view ranges by clicking on the nodes. 

• [STEP 11] Add a sheet for the elevation by mouse right-clicking and clicking [New Sheet] on Sheets(all) from [Project 

Browser] > Select 11×17 titleblock page that you created > Rename the sheet – Sheet number [A601], Sheet name – 

Interior Elevation > Once the empty sheet is open > Drag the elevation view from [Project Browser] to the sheet > 

Rename the view title [E-LIVING-N] > Then you can see the elevation symbol name and view name updated on the 

floor plan 
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• [STEP 12] Usually, we want to show the boundary of elevation in a bold line. On your sheet, add [Detail Line] from 

[Annotation] tab, under [Detail] panel, or type [DL] > Select [Wide Lines] from [Modify] tab, under [Line Styles] > Trace 

the boundary lines 

To add a section view 

• [STEP 1] You will use similar steps to create section views 

• [STEP 2] Click [Section] from [View] tab, under [Create] panel 

• [STEP 3] Draw a section line by clicking two points, then you can change the view direction and boundary of the view 
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• [STEP 4] Set a sheet for the section 

(CO 2) Add/Edit Detail views (CO 2) Add/Edit Detail views 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=104 

Add detailed views 

• [STEP 1] Click [Callout] from [View] tab, under [Create] panel 
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• [STEP 2] Draw the boundary of a view on your floor plan > then [Level 2-Callout] will be automatically created under 

[Floor plans] > Rename the view to [Level 2 – Restrooms] > If needed, update the scale 

• [STEP 3] Create an elevation view and a section view on the detail view > add details > Update scales > Hide [elevation 

symbol] on [Level 2] floor plan > Hide [Section symbol] on [Level 2 – Restrooms] detail view and [Level 2] floor plan 

• [STEP 4] Add the detail views to the sheet [A701-Restroom 1] 
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(CO 3) Add Texts & Annotations (CO 3) Add Texts & Annotations 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=104 

Annotation (Texts, Notes, and Dimensions) can be added to any views and sheets 

In this tutorial, you will practice the [TEXT] tool to add texts and notes 

• [STEP 1] Open a [view] from [sheet] by double-clicking the view > On the view, click [Text] from [Annotate] tab, under 

[Text] panel > Select a text type from [Properties] panel > Drag and drop to make a text box > Add text 
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Note. If you need a different style of text type, you can duplicate the type and edit 

• [STEP 2] Add a leader line(s) by clicking the [Leader] icon from the [Modify] tab > adjust arrow direction and the leader 

line 
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(CO 4) Add/Edit Rooms, Room tags, Room separators (CO 4) Add/Edit Rooms, Room tags, Room separators 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=104 

Another useful annotation tool is creating, defining, and tagging rooms in Revit. Once you have walls, Revit recognizes the 

walls as the boundary of the rooms. However, if you have unclear boundaries, you have to define room boundary by using 

[Room Separator] first 

Confirm room boundaries 

• [STEP 1] Click [Room] from [Architecture] tab, under [Room & Area] panel 

• [STEP 2] Hover the mouse over the floor plan to find a closed room. You can confirm the boundaries by clicking 

[Highlight Boundaries] 
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• [STEP 3] Click [Close] to hide the highlighted boundaries 

Define boundaries 

• [STEP 1] To define boundaries, click [Room Separator] from [Architecture] tab, under [Room & Area] panel 

• [STEP 2] Using [Draw] tool to draw separated boundaries, then you can manually define boundaries. 
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Create rooms 

• [STEP 1] Click [Room] from [Architecture] tab, under [Room & Area] panel 

• [STEP 2] Hover over each room and click once with the mouse to define the room boundary. You will see a tag that 

reads [ROOM] and a [X] showing the extent of the room. Continue for each room. 

Edit tags 

• [STEP 1] Click a room tag (NAME) two times, then you can edit the room name. Click a room tag (NUMBER) two 

times. Then you can edit the room number. 

Note. If the rooms are located on the 1st floor, the number starts from 101. If the rooms are located on the 2nd floor, 

the number starts from 201. 

• [STEP 2] Move the room tags outside of the room to avoid overlapping with model lines and the room names > Select 

all room tags > Check [Leader Line] box > Move the room tags to the outside of the room 

Revit Session 9  |  238



(CO 5) Add/Edit a color fill scheme (CO 5) Add/Edit a color fill scheme 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=104 

You can use the [color fill legend] to place rooms and spaces after adding rooms. Color coding plans can help the client 

understand the relationship between public and private, work, and rest spaces. 

Add a color fill legend 

• [STEP 1] Click a [room] on a floor plan > Add [PUBLIC], [SEMI-PRIVATE], or [PRIVATE] on [Department] from 

[Properties] palette > If you already added one of the three options, you can select from the drop-down menu. 
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• [STEP 2] Repeat step 1 for all rooms 

• [STEP 3] Duplicate floor plans for only the color-filled plans by right-clicking a view > select [Duplicate view] > select 

[Duplicate with Detailing] > Rename the copied views 

• [STEP 4] Open the duplicated views > Click [Color Fill Legend] from [Annotate] tab, under [Color Fill] panel > Click on 

a floor plan, then [Choose Space Type and Color Scheme] window will open > Confirm Space type: Room, Color 

Scheme: Department > Click [OK] then the color-filled legend and color will show. 
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• [STEP 5] Repeat this step 4 for another plan 

• [STEP 6] To update color, Click the legend > click [Edit Scheme] > Define color> Click [OK] to finish color scheme 
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SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 17. Add/edit views, lighting, & 
materials 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Set perspective views 

(CO 2) Set Isometric views 

(CO 3) Edit Views – Graphic Display styles 

(CO 4) Test Render 

(CO 5) Set sun 

(CO 6) Edit Artificial lighting 

(CO 7) Add/Edit materials 

(CO 8) Render material managements 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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Lecture Contents Lecture Contents 

(CO 1) Set perspective views (CO 1) Set perspective views 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106 

Revit supports perspective views and isometric views. 

For more information about 3D views, please read this page 

To create a camera view for a perspective view 

• [STEP 1] Open a floor plan [Level 1] to create a camera view 

• [STEP 2] Click a drop down menu of [3D view] > [Camera view] from the [View] tab, under [Create] panel 

• [STEP 3] On the floor plan, click the location of the camera position, click the target position > The perspective view 

will pop up the window. 

To reposition the camera view 

• [STEP 1] In order to adjust the view, you will open the camera view that you would like to adjust and the floor plan 

together. Type (WT) to see the tile view and type (ZA) to see zoom in all 

• [STEP 2] Click the frame of the perspective view > you can reposition by controlling the 3D wheel on the top-right 

corner of the view and resize the camera view by adjusting the nodes 

• [STEP 3] You can also change the camera position and the target position on your floor plan. On the Properties panel, 

change eye elevation & Target elevation, turn off Far Clip Active, and view the name. 
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Image-print size update for the perspective view 

• [STEP 1] Click the view frame 

• [STEP 2] Click the [Size Crop] icon from the [Modify] tab 

• [STEP 3] On Crop Region Size window, check [Scale (locked proportions)] 

• [STEP 4] Change the width of what you want to make, and then the height will automatically change with the view 

ratio you made. 

• [STEP 5] If you want to change the proportion, you check the [Field of view] and change the proportion. Click Apply. 

• [STEP 6] Then again, check [Scale] to change the size of the view 

• [STEP 7] Click [ok] to finish 
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(CO 2) Set Isometric views (CO 2) Set Isometric views 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106 

Set Isometric view 

• [STEP 1] To add an Isometric view, Click the drop-down menu of [3D view] from the [view] tab, under [Create] panel, 

click [Default 3D view] > The Isometric view will pop up 

• [STEP 2] To edit the boundary of the view, Click the [section box] option on the [properties] palette 

• [STEP 3] Click the [section box] on the view > Drag the arrows toward the model to create a dynamic slice of the 

model 
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(CO 3) Edit Views – Graphic Display styles (CO 3) Edit Views – Graphic Display styles 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106 

To set the graphic display styles 

• Once you click [Graphic Display] on the [view navigation] panel, click one of the six options, then you can change the 

styles of graphic 

• Examples of the six graphic style preset 
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Wireframe &  Hidden Line 

Shaded & Consistent Colors 

Realistic & Custom 

To modify Graphic Display Options 

• [STEP 1] Click [Graphic Display] on the [view navigation] panel > click [Graphic Display Options] 

• [STEP 2] Modify the properties that are appropriate for your project 

For a quick presentation, I like to use these settings 
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• [STEP 3] Click [Apply] to confirm what you changed, click [Ok] to set the style 

(CO 4) Test Render (CO 4) Test Render 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106 

To do a test render, you need to adjust the render settings 

• [STEP 1] Click [Render] from the [View] tab, under [Presentation] 

or Click [Rendering Dialog] on the [view navigation] panel 

• [STEP 2] Adjust settings 

◦ Confirm Setting – Draft for a test render 

◦ Change Lighting scheme – interior for an interior scene 

◦ Change Sun Setting – Sun and Artificial 

◦ Change Background style 

◦ Click [adjust Exposure] if needed 
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• [STEP 3] Click Render to see the result. You can stop if it shows all right, you do not need to wait until the completion. 

(CO 5) Set sun (CO 5) Set sun 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106 

Setting Sun 

• [STEP 1] Click [Sun Path] On > Click [Shadow] On 

• [STEP 2] Click Sun Settings to adjust sun direction 

• [STEP 3] Select Still for a specific time 

• [STEP 4] Change Display setting to Realistic or Render to see the sun direction and material 
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(CO 6) Edit Artificial lighting (CO 6) Edit Artificial lighting 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106 

Review the default lighting setting 

• [STEP 1] To see an accurate lighting setting, change the render setting to [Interior: Artificial only] and [High] quality 
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• [STEP 2] Open Visibility/Graphics Overrides, or type [VV] for 3D view 

• [STEP 3] Turn on Lighting Source to see the light source 

Lighting setting 

• [STEP 1] Click the lighting fixture that you want to modify 

• [STEP 2] Click Edit Type > Click Duplicate and name the new type 

• [STEP 3] Modify Photometrics [initial intensity] >  I recommend to adjust the value of [Illuminance] and [at a distance 

of] 

Please refer to this page for the recommended lighting level (Lux) for activities Repeat this step for all other lighting 
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sources 

• [STEP 4] Test render to see if the light fixtures are at the right setting. 

• Recessed indirect lighting 

◦ Recessed Ceiling with Light in Revit * Light Tutorial * 
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(CO 7) Add/Edit materials (CO 7) Add/Edit materials 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106 

Apply materials in Family type 

• [STEP 1] Click an object that you want to add or change materials 

• [STEP 2] Click [Edit Type] to change Materials and Finishes 

• [STEP 3] Duplicate if needed 

• [STEP 4] Click Material Value (Not all objects have this option, but many family files do this option) to add or modify 

the material. Then Material Browser will pop up 

• [STEP 5] If you already made a material you want to use, please select the material and click ok to finish 

• [STEP 6] If you want to make a new material, click Create New Material 

• [STEP 7] Mouse right-click and click to [Rename] the new material [Ex. 000-FB-01-White] 
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• [STEP 8] You can change Identity, Graphics, and Appearance. To add material from Revit Library, click Appearance, 

Click [Replace] this Asset. Asset Browser will pop up 

• [STEP 9] Search a material from Appearance Library 

• [STEP 10] Click a replace icon 

• [STEP 11] Click Information, name change if this is a unique material 

• [STEP 10] Click ok to apply 

Painting materials (For Walls, Floors, and Ceilings) 

• [STEP 1] To use [Paint] tool, click [Paint] from the [Modify] tab 

• [STEP 2] Click a material that you want to use from Material Browser. If you do not find the material that you want to 

use in the Material Browser, you must add a new material first and then apply the paint tool 

• [STEP 3] Click a face that you want to change, use the Tab key to select right face 
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• [STEP 4] You also can remove the paint material by using the Remove Paint tool 

• [STEP 5] Use [Split Face] (If the surface needs to be separated), Click [Split Face] from [Modify] tab 

• [STEP 6] Click the elements (Wall, Floor, Ceiling) you want to split face. You may need to use the TAB key to select the 

elements 

• [STEP 7] Draw a closed line to divide the surface. You may need to open an elevation view, a floor plan, or a ceiling 

plan to draw the lines. 
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• [STEP 8] Click Green checkmark to finish 

• [STEP 9] Then use the Paint tool to apply the material 

Decal (Flat Surface – Carpet or pictures) 

• [STEP 1] To create Decal, click Decal Types from the Insert tab 

• [STEP 2] Please create a new Decal, Name it, insert the image, and click ok 
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• [STEP 3] To place a Decal, Click Place Decal from the insert tab 

• [STEP 4] Place on a surface 

• [STEP 5] Change size and location from views 

(CO 8) Render material managements (CO 8) Render material managements 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=106 
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Manage material 

• [STEP 1] Click [Materials] from [Manage] tab 

• [STEP 2] In this [Material Browser], you can add and modify materials 

• [STEP 3] If you need to apply an imported object (CAD or Sketchup), use [Object Styles] 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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Chapter 18. Create Revit rendering, Revit 
clouding rendering 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Insert other types of files – Sketchup, AutoCAD 

(CO 2) Advanced render settings 

(CO 3) Edit render qualities 

(CO 4) Understand and make cloud renderings 

(CO 5) Save Rendering outputs 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Insert other types of files – Sketchup, AutoCAD (CO 1) Insert other types of files – Sketchup, AutoCAD 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=108 

Although many manufactures provide Revit Family and Revit also provide numerous libraries, designers always seek new 

models and objects for their design and renderings. Sketchup 3D Warehouse provides a great library from designers and 

manufacturers. I added three Video tutorials to import the Sketchup model to Revit Family for your reference. You may try. 

• Sketchup Model to Revit 

Importing SketchUp Files into Revit Tutorial 

• Sketchup Model to Revit – Material changes 

Revit Architecture | Convert SketchUp Models Into Revit(With Materials) 

• Complex 3D max Model to Revit – Hide the complex model lines in Revit (Super advanced level) 

AMAZING REVIT 1 – FROM 3DS MAX TO REVIT WITHOUT VIEWING TRIANGLES EDGES 

Sketchup model to Revit with updating material changes 

• [STEP 1] Sketchup Model to DXF file 

◦ Open the Sketchup model in Sketchup, or your download the furniture model from a 3D warehouse. In this 

process, you may need Sketchup Pro. 

◦ Create layers by material. If you have 3 materials, create 3 layers with unique names (e.g. 000_Chair_sk_seat_01, 

000_Chair_sk_leg_01, 000_Chair_sk_base_01) 

◦ The entire model until there is nothing left to explode. 
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Modeling credit: Vojislav N. downloaded from 3D warehouse 

◦ Select one material > Mouse right click and Select > All with the same material 

Modeling credit: Vojislav N. downloaded from 3D warehouse 

◦ Change layer in [Entity Info] Tray by selecting the desired layer that you previously made 

Modeling credit: Vojislav N. downloaded from 3D warehouse 

◦ Do the same procedure (material selection and layer change) for the other materials 

◦ Export > 3D model > Select DXF file > Click option > Select only Faces > Version 2007> OK > Export 
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Modeling credit: Vojislav N. downloaded from 3D warehouse 

• [STEP 2] DXF file Properties change 

◦ Open AutoCAD 

◦ Open the DXF file in AutoCAD. It will show in a 3D view 

◦ Select all lines by pressing [Ctrl+A] 

◦ Change Object color from [Home] tab > Color [By Layer] 

◦ Save the DXF file with Version 2007 

• [STEP 3] Import DWF file (Furniture) to Revit 

◦ File > New > Family > Select Family Template file (Furniture) 

◦ Insert tab > Import CAD > Change files of type to DXF > Select the file > Click [Open] > Save the family file > Load 
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into Project 

• [STEP 4] Change materials for an imported file in the Revit project file 

◦ Manage tab > Object Style 

◦ Click Imported objects 

◦ Change material by clicking the material slot 
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(CO 2) Advanced render settings (CO 2) Advanced render settings 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=108 

Region renders 

The Region render function saves time while rendering 

• [STEP 1] Check Region on Render Setting 

• [STEP 2] You will see RED square on the perspective view. You can adjust the box that you wish to render 

Output Settings 

The default setting is Screen, which shows the entire screen size. If you need a perspective view for presentations or print, 

your rendering size should be a different setting 

• [STEP 1] Click Print on Render Settings 

• [STEP 2] Change the resolution 

◦ 75 DPI – Screen presentation 

◦ 150 DPI – Regular print size 

◦ 300 DPI – Fine print size 

◦ 600 DPI – Not used 

• [STEP 3] If you need to change image size, you can adjust the width and height on Crop Region Size 
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Render image 

• [STEP 1] After your rendering process is done, you can save the image in the Revit project file for your future use. You 

can find the saved rendering under the project browser by clicking [Save to Project] on the [Rendering settings] 

window. You can include the rendered images on the sheets with a titleblock. 

• [STEP 2] You can save the rendering with different formats by clicking [Export] under the image on [Render settings]. 

Typically, save JPG for photoshopping. 

Render Background 

• [STEP 1] You can add a background for your render [background] 

◦ The default setting can be Revit Sky, which can correspond with a specific date and time. 

◦ You are also able to add an image as a background. 

◦ You can set as a Transparent image. The file type must be PNG or TIFF file to save a transparent image for the 

background. 

(CO 3) Edit render qualities (CO 3) Edit render qualities 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=108 
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Change the render quality 

• Draft – for a test render, but not recommended, because of lighting quality, reflection, bump, and refraction on 

finishesDraft-Render time 1min 

• Med – is recommended for a test render. Not the best quality, but it is acceptable 

• High – is recommended for a final render because of time and quality 

• Best – Although it produces the best quality, it is not recommended due to rendering time. Best-Render time 2hrs 
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(CO 4) Understand and make Cloud Renderings (CO 4) Understand and make Cloud Renderings 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=108 

Cloud rendering 

Autodesk provides users with Cloud rendering. Design firms have great hardware to quickly render but Autodesk also 

provides its servers for rendering. The render quality is a bit better and faster than Revit rendering. Cloud rendering is a 

paid service, however, for educational purposes, it is offered for free. 

• [STEP 1] Once your render settings are what you want to produce, click [Render in Cloud] from [View] tab, under 

[Presentation] panel 

• [STEP 2] If you are a first time user of Cloud Render, you must Sign-in to an Autodesk account (email, PW, text code 

required) 

• [STEP 3] Double-check your view name, output type (Still image), Render Quality, Image Size, Exposure 

• [STEP 4] Click email when complete 

• [STEP 5] Click Render 

(CO 5) Save Cloud Rendering outputs (CO 5) Save Cloud Rendering outputs 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=108 

Revit Session 11  |  268

https://iastate.pressbooks.pub/visualgraphiccomm/?p=108#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=108#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=108#pb-interactive-content
https://iastate.pressbooks.pub/visualgraphiccomm/?p=108#pb-interactive-content


Get rendering outputs 

• [STEP 1] Check the render results 

• [STEP 2] Once you received the notification email, you can check the results in Render Gallery 

• [STEP 3] The Render Gallery website will open, click View Project 

• [STEP 4] Click the rendered thumbnail image > Click [Post-Processing] to change expose level and color balance 

image credit: Autodesk cloud rendering 

• [STEP 5] Click Download Icon > Click JPEG 

• [STEP 6] If you need Transparent Background (for photoshop), click PNG 
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image credit: Autodesk cloud rendering 

Revit rendering vs. Cloud rendering 

Revit Rendering Revit Cloud Rendering 

Render time Longer Vary (shorter) 

Hardware use Your hardware No hardware required 

Control – Image size Fully controllable Few options 

Control – Lighting Manual Automatic 

SAVE the file before closing the application. 

Save in a different location for the backup (e.g., a cloud folder) 
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PART THREE. ENSCAPE 

Chapter 19. Introduction of Enscape Chapter 19. Introduction of Enscape 

• Understand what is Enscape 

• Control/navigate Enscape 

• Create views 

• Add model backgrounds 

• Add Entourages 

• Render images 

Chapter 20. Chapter 20. Edit Model and Materials Edit Model and Materials 

• Understand workflow, name of the material 

• Use 3D Grass, Water, Reflective, textures 

• Change to Architecture Maquette (White model, Outline) & Light mode 

• Create Orthometric views 

Chapter 21. Chapter 21. Edit Lighting and Create Video Edit Lighting and Create Video 

• Save, and load presets 

• Set and adjust artificial lightings 

• Create a walk-through video 

Chapter 22. Chapter 22. Edit Render outputs Edit Render outputs 

• Export enlarged jpg files (Original, ID) for print 

• Create Executable file 

• Create Render Panorama image 
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Chapter 19. Introduction to Enscape 

Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Understand what is Enscape 
(CO 2) Control/navigate Enscape 
(CO 3) Create views 
(CO 4) Add model backgrounds 
(CO 5) Add Entourages 
(CO 6) Render images 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Understand what Enscape is (CO 1) Understand what Enscape is 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=110 

Enscape is a commercial real-time rendering and virtual reality “plug-in” for Revit, Sketchup, Rhino, ArchiCAD, & 

Vectorworks. 

It is mainly used in the AEC industry and is developed and maintained by Enscape GmbH, founded in 2013 and based in 

Karlsruhe, Germany. 
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Enscape features. Enscape features. Information from: Enscape website 

• [FEATURE 1] Real-time walk-through 

CAYAS Architects was able to save 75% of their time to produce 3D visualizations by using Enscape 

• [FEATURE 2] Virtual Reality 

“A key add-in for Revit and Rhino workflow through to VR.” Forster+Partners 

“Now, with Enscape, our clients are amazed with what we show them. They are able to actually experience their 

project before it is even built. Enscape helps us to do a better job.” HMFH Architects 

• [FEATURE 3] Export functions 

“Design is always an iterative process, but Enscape has made it a dynamic one” Turner Fleischer 

◦ Batch export 

◦ 360-degree panorama 

◦ Video exports 

◦ Standalones – an EXE file 

• [FEATURE 4] Various visual settings 

◦ Clouds and backgrounds 

◦ Time of day change 

◦ White model mode 

◦ Light analysis mode 

◦ Volume fog effects 

◦ Depth of Field option 

◦ Ortho views 

◦ BIM information 

• [FEATURE 5] Asset library – more than 1000 options 

Other architectural rendering applications Other architectural rendering applications 

• Vray 

• Lumion 3D 

• Twinmotion 

• Corona 

Read this article to learn more about other rendering applications in this link. 

Download and install Enscape Download and install Enscape 

• [STEP 1] Request Enscape educational license form the link 
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• [STEP 2] Double click the downloaded Setup file. 

• [STEP 3] Enscape requires four pre-installed programs, and you must install the necessary application (all free) to run 

Enscape. 

• [STEP 4] In an advanced setup, you can install Enscape only for Revit. 

If you would like to use Enscape Sketchup and Revit, you can select all (Default setting). 

• [STEP 5] Once the installation process is completed, open Revit. Note. Enscape is not stand-alone software. Enscape is 

a plug-in application in Revit, Sketchup, and Rhino. Therefore, you must have your application open in order to use 

Enscape. 

• [STEP 6] Once you click Enscape Start, Enscape will ask for the license code to activate. 

Please copy and paste the codes from your email and activate it. 

Required Software information can be found in this link. 

System requirements information can be found in this link 

• To check your graphic drivers (Windows) 

◦ Open your “This PC” on your Desktop 

◦ Mouse “right-click” > Click “Properties” > Click “Device Manager” on the left side of the panel > Find “Display 

adapters” and see the graphic drivers 
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(CO 2) Control/navigate Enscape (CO 2) Control/navigate Enscape 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=110 

Open your project file and open a perspective that you want to make a rendered image in Enscape. Start Enscape 

• [STEP 1] Click [Enscape] tab 

• [STEP 2] Select the view that you would like to start on [Active Document] panel 

• [STEP 3] Click [Start] on [Control] panel. Then it would be best if you waited a few seconds or minutes to launch the 

plug-in 

Once Enscape is open, familiarize yourself with the navigation control 

• [OPT 1] For the best practice, use dual monitors to see the Enscape real-time render on one monitor, your Revit 

project on the other monitor. 
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• [OPT 2] If you do not have two monitors, you can split your screen with two windows 

• Use both keyboard and mouse to navigate Enscape 

Adjust settings There are two types of settings. 

• [OPT 1] General Settings 

This setting is for the file and saves locations, mouse and keyboard control, licensing, etc. 

Enscape Session 1  |  278



• [OPT 2] Visual Settings 

This setting is to render styles, image quality, camera settings, atmosphere, background, render settings, etc. 

• Below are the settings that I used in the rendering below 

• the rendering preview 
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(CO 3) Create views (CO 3) Create views 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=110 

If you find a view while you navigate the real-time view from Enscape, you can create/ save a view 

• [STEP 1] Once you find the view, stop to navigate 

• [STEP 2] Click “Create 3D view” from the tools panel 

• [STEP 3] Name the view 

• [STEP 4] You can find the view that you just created on the Revit Project browser 
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• [STEP 5] To go back your views that you created, click the view name on the [Active Document] panel 

(CO 4) Add model backgrounds (CO 4) Add model backgrounds 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=110 

There are two options to change the model background 

• [OPT 1] Change your Atmosphere on the visual settings to change the model backgrounds 

• [OPT 2] Try to use Skybox. Find free skyboxes from this link 

(CO 5) Add Entourages (CO 5) Add Entourages 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=110 

Add Enscape models from Asset Library 

• [STEP 1] Click Asset Library from the Tools panel 

• [STEP 2] Search items by category or tags 

• [STEP 3] Open a floor plan that you want to add the selected Enscape model to the Revit model 

• [STEP 4] Select the model and place it on your floor plan. Use Move, Rotate commands to place the Enscape model. 

Also, confirm the positions on your perspective view. 
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• [STEP 5] Once the placement is done, press [ESC] to go back to the library 

(CO 6) Render images (CO 6) Render images 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=110 

To make the final render To make the final render 

• [STEP 1] Click [Visual Settings] to set render size, file location, and file type. 

• [STEP 2] Click [Capture] in your visual settings 

• [STEP 3] Select the [Resolution] of the final rendering – Typically Full HD for PPT presentation, Ultra HD for Print 

version presentation. If your render size is unique, please select Custom and set the pixel size. 

• [STEP 4] Check [Show Safe Frame] to see the preview on your real-time view 

• [STEP 5] Check [Export Object-ID, Material-ID, and Depth Chanel], Adjust the depth for the Depth Chanel 

• [STEP 6] Set a render location to save your final render image file by clicking the Folder 

• [STEP 7] Select a file format, typically [ JPG] 

• [STEP 8] Select the view name that you want to generate a final render 

• [STEP 9] Click [Render image] from [Enscape] tab, under [Tools] panel, to get the final render image outside of the file. 

You may click “Render image (into the document)” to use the rendered image on your Revit document. This way, you 

can add your final render image to your sheet 
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Free resources Free resources 

• Link 1 

• Link 2 
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Chapter 20. Edit model & materials 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Understand workflow, name of the material 
(CO 2) Use 3D Grass, Water, Reflective, textures 
(CO 3) Change to Architecture Maquette (White model, Outline) & Light mode 
(CO 4) Create Orthometric views 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Understand workflow, name of the material (CO 1) Understand workflow, name of the material 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=112 

To manage your file size for faster real-time rendering in Enscape, you would be better to reduce your file size 

To apply a new material To apply a new material 

• [STEP 1] Click [Material Browser] icon on [Material and Finish] category in the [Properties] palette 

• [STEP 2] Click [Create New Material] on [Material Browser] 

• [STEP 3] Rename the material that you created (Example. 001_XX_01_Description) 

• [STEP 4] Check [Use Render Appearance] on [Graphic] tab 

• [STEP 5] Click the [Appearance] tab on the [material browser] 

• [STEP 6] Click [Replace] Icon 

• [STEP 7] Click [ Appearance Library] 

• [STEP 8] Select a category 

• [STEP 9] Click a specific material that you would like to apply, or change > click the [replace] icon 
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• [STEP 10] On the [Material Browser], click the Duplication icon. This process is recommended to make a unique 

material 

• [STEP 11] If the material image needs to be changed, click the image name. If the material size, location, or rotate, click 

image 

• [STEP 12] Change the scale, offset, or rotate > Click done 

• [STEP 13] Update Information on the [Identity] tab 

◦ Description = Material tag information 

◦ Other information = Material schedule information 
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• [STEP 14] Update Information on the [Graphics] tab 

◦ Shading, Check [Use Render Appearance] 

◦ Update [Surface Pattern] if needed 

◦ Update [Cut Pattern] if needed 

• [STEP 15] Update Information on the [Appearance] tab 

◦ Information name = Should be unique 

◦ Generic = Image or color 

◦ Reflectivity 

◦ Transparency 

◦ Self-illumination – Create self-illuminated material like a light source 

◦ Bump – Create a bumpy texture on a surface 
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• [STEP 16] Click [Apply] > click [ok] 
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For material, Enscape uses most of Revit material properties 

Materials in Revit can be found at this link 

Use sample materials from this link 

(CO 2) Use 3D Grass and Water (CO 2) Use 3D Grass and Water 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=112 
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Enscape requires a special name for Water and Grass. 

The material name must include [water] for water materials. 

The material name must include [grass] for grass materials. 

(CO 3) Change to Architecture Maquette (White model, Outline) & Light mode (CO 3) Change to Architecture Maquette (White model, Outline) & Light mode 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=112 

Designers use white models to discuss the shape or form of space. 

• [STEP 1] Open [visual settings] 

• [STEP 2] Change mode to [White] 
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The designer also uses light mode to show lighting intensity. You can see where hot spots are and where the areas that need 

more lighting. 

• [STEP 1] Open [visual settings.] 

• [STEP 2] Change the mode to [Light view.] 

• [STEP 3] You may uncheck [Automatic Scale] for manual 

291  |  Enscape Session 2



(CO 4) Create Orthometric views (CO 4) Create Orthometric views 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=112 

To create an isometric view via Enscape, you need an isometric view on your Revit file. 

• [STEP 1] Create a Default 3D view by clicking the [3D view] from the View] tab, under [Create] panel 

• [STEP 2] Use [section box] and hide in view by element or category to hide unnecessary items 

• [STEP 3] Synchronize the view by selecting [view name] 

• [STEP 4] Change the Projection to [Orthographic] from [Visual Settings] under [Rendering] 

• [STEP 5] You may change the [render style mode] on your [visual settings] 
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• [STEP 6] You also may change views using numbers on the keyboard 

For a floor plan, press [ 5 ] 

References References 
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293  |  Enscape Session 2

https://enscape3d.com/community/blog/knowledgebase/revit-material-parameters/
https://enscape3d.com/community/blog/knowledgebase/revit-material-parameters/
https://enscape3d.com/educational-license/


Chapter 21. Edit lighting and create a video 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Save and load presets 
(CO 2) Set and adjust artificial lightings 
(CO 3) Create a walk-through video 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 
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  Lecture Contents Lecture Contents 

(CO 1) Save and load presets (CO 1) Save and load presets 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=114 

The saving and loading presets are very helpful if you need to render multiple images. You will save a lot of time and produce 

consistent image qualities. 

You can save the visual settingsave the visual setting that you modified 

• [STEP 1] Click Presets 

• [STEP 2] Click Save Preset > Save to Project or Save to File 

• [STEP 3] Name the preset 

• It is recommended to save three types of preset [Perspective-Day, Perspective-Night, and Isometric] 

To load a presetload a preset that you already saved 

• [STEP 1] Click Presets 

• [STEP 2] Click load Preset > Load from Project, or you may load from the file 

• [STEP 3] Select a preset that you would like to load > Click OK 
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(CO 2) Set and adjust artificial lightings (CO 2) Set and adjust artificial lightings 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=114 

For better artificial lighting simulation artificial lighting simulation 

• [STEP 1] Use a night-time scene time (sunset or sunrise would work as well) 

• [STEP 2] Turn off “Auto Exposure” in Enscape visual settings 

◦ Exposure Brightness = 60% ~ 80% (Nighttime scene) 

◦ Exposure Brightness = 51%~53% (Day time scene) 

• [STEP 3] The render quality should be High or Ultra 

• [STEP 4] Vignette effect = 0% 

• [STEP 5] Artificial Light Brightness = 100% ~ 150% 

Once you change the time of day, you must click “create 3D view” to save that time of day. 

• [STEP 1] Click [Create 3D view] from the [Enscape] tab 

• [STEP 2] Name the view 
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You may need to adjust the value of Illuminance on the “Initial Intensity” of lighting properties. 

Find/use IES lighting from this link 
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Use/adjust self-illumination materials for lighting sources 

(CO 3) Create a walk-through video (CO 3) Create a walk-through video 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=114 

To create a video patha video path with scenes 

• [STEP 1] Click “Video Editor” from the Enscape tab 

• [STEP 2] Click “Add keyframe” – Once you click “Add keyframe,” the setting will be saved 
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• [STEP 3] Change the scene by moving the scene 

• [STEP 4] Once you think the next scene is the right position (recommend foot walk to see the scene from the same 

height), click “Add keyframe,” then you can see the second frame is added. 

• [STEP 5] You may check the preview to see how this works. 

• [STEP 6] Repeat step 3 to 5 to create a complete path for a video 
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• [STEP 7] Click a [frame] and change the settings (time of the day, duration of the movement, camera field of view, and 

camera position) and click “Apply” to apply the changes 

• [STEP 8] You can repeat other frames to change the settings 
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• [STEP 9] You can get out of the keyframe editor by clicking Back, Click Preview to see the results 

To save a video path save a video path 

• [STEP 1] Click “Save Path” from the Enscape tab 

• [STEP 2] Make a unique name for the path 
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To render the video render the video 

• [STEP 1] Load camera path by clicking “Camera Path” > “Load path” from the Enscape tab 

• [STEP 2] Change video size from Visual Setting – Resolution (HD is recommended), the quality can be [Web], FPS 

must be [30] 

• [STEP 3] Click “Render Video” to render the path 

Note. To render the video, it will take a while because of the pictures that the video renders. Typically, if you render a 

1-second video, Enscape renders 30 frames. If one frame takes 10 seconds to render, a total 1-second Video takes 300 

seconds to render. Enscape does a great job because Revit rendering takes 5 minutes to render one frame. 

References References 
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Chapter 22. Edit render outputs 

  Session Objectives Session Objectives 

Upon completing this session, students will be able to: 

(CO 1) Export enlarged jpg files (Original, ID) for print 
(CO 2) Create Executable file 
(CO 3) Create Render Panorama image 

  Session Highlights Session Highlights 

At the end of the session, students can create the graphics below. 

  Lecture Contents Lecture Contents 

(CO 1) Export enlarged jpg files (Original, ID) for print (CO 1) Export enlarged jpg files (Original, ID) for print 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=116 

Refer to [lecture 14.1, CO 2], for the final render image process 

If you need a special size of render image, change the resolution to Custom and change the values from Capture in Visual 
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Settings 

You can use the ID images and Depth map to adjust the rendering in photoshop. 

(CO 2) Create Executable file (CO 2) Create Executable file 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=116 

To export the EXE file To export the EXE file 

EXE file type is for a presentation, it does not require any programs like Revit, nor Enscape, material links, and lighting/

render settings. 

• [STEP 1] Click [Start] to launch Enscape and confirm your model is ready for export. 
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• [STEP 2] Select view to start 

• [STEP 3] Add information (Icon, Title, Load first screen) from [Customization] on [General Settings] 

• [STEP 4] Click Export > Exe Standalone 

• [STEP 5] Save > Name the file name and wait until the file is created 
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(CO 3) Create Render Panorama image (CO 3) Create Render Panorama image 

A YouTube element has been excluded from this version of the text. You can view it online here: https://iastate.pressbooks.pub/

visualgraphiccomm/?p=116 

To create Render Panorama To create Render Panorama 

(This option creates only one 360-degree rendering image with QR code at the same time) 

• [STEP 1] Select a view to create a 360-degree rendering image (The center of a room/space) 

• [STEP 2] Click Enscape Start. Confirm your Projection mode is [Perspective] 

• [STEP 3] Click Render Panorama. The render takes time because this panorama needs to render 16 images (for the 

normal setting) 

• [STEP 4] Automatically saved on [Manage Uploads], open [Manage Uploads] 
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[STEP 5] Click the rendered image > Upload the rendered image in ENSCAPE CLOUD 

• [STEP 6] Click the file to open the web browser or use a QR code 

• [STEP 7] And the rendered image file and the QR code can be saved in JPG 

Tips from Enscape using Panorama view Enscape using Panorama view 

Please read this link for using the panorama view 

Please read this link for an advanced level using panorama images 
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Appendix: Ancillaries 
◦ File package for a student – Download 

▪ Base drawings 

▪ Source models 

▪ Material images 

◦ File package for an instructor – Request to the author via email 

(yongyeon@iastate.edu or choyongyeon1983@gmail.com) with documentation, they are a faculty member. 

▪ Base drawings 

▪ Source models 

▪ Material images 

▪ AutoCAD, Revit, and Enscape models 

 

Recommended lecture schedule and to-do list for each session: 
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Week Session Contents 

01 01 

Introduction of AutoCAD 

• What is the application & 4 different AutoCAD 
• How to install the application 
• Understand AutoCAD interface – Ribbon, Panels, Model space, Layout tabs, Status bar, & Properties 
• AutoCAD setup tips – Options, Unites, Workspace 
• Types and structure of drawings  in Auto CAD– Floor plan, RCP, Elevation, Section, & Details 
• Input commands and understand different selections 
• Understand basic drawing tools– Origin, Line, Move, Rotate, Copy 
• Attach image/PDF/CAD and Adjust the scale 
• Set the project folder, Save the file, and backups 

02 

Draw Floor Plans 

• Understand Layers – Name, Line type, Thickness, & Color 
• Draw centerlines – Line, Ortho, & Offest 
• Draw exterior/interior walls, floor, millwork & openings – Polyline, Spline, Circle, Rectecgul, Object 

Snap, Mirror, Fillet, Trim, Extend, Array, & Match Properties 

02 01 Finalize (2) Floor plans layout (1st floor & 2nd floor for the House) – Walls, Floor, Millwork, & Openings 

02 

Create Dimensions and Components 

• Add/Edit dimensions (in model space)– Dim, & Dimension style 
• Add/Edit blocks from AutoCAD Tool Palette & Other sources – Door, Window, Column, Plumbing, 

Furniture & Equipment 
• Create custom blocks – Custom furniture 

03 01 

Draw Elevations and Sections 

• Draw a section 
• Draw an elevation from the Floor plan 
• Add/Edit Text & Annotation (in model space) – MText, Text style, M leader, & Multileader Style 

02 

Add components (Window, Column, Plumbing, Furniture, & Equipment) in (2) Floor plans (Follow the wall 
layout and millwork, design your own furniture layout) 

Finalize (1) Section (House-Section A-A’) and (1) Elevation (refer House-Section C-C’) – with furniture, 
dimensions, and annotations 

04 01 

Draw Ceiling Plans 

• Draw Ceiling Plans from Floor plan 
• Add/Edit Hatch 
• Create Legends 
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02 

Set Sheets 

• Understand the Model space and Paper spaces 
• Set a new layout – Page layout, & Plot styles 
• Set views in Paper spaces – Defpoints, Scaling 
• Add/Edit/Draw a titleblock 

05 01 
Symbols and prints 

• Add/Edit symbols in Paper spaces – drawing title, elevation symbol and section letters, north arrow 
• Printing 

02 

Add Hatches in the floor plans, sections, and ceiling plans 

Finalize (2) Ceiling plans (1st floor & 2nd floor for the House) – design your own lighting layout for the 
House 

Create a PDF drawing set 

06 01 

Introduction to Revit 

• Purpose of using Revit – How & Why Interior Design uses Revit 
• Install Revit 
• Understand Project Templates – Default and Own 
• Save Revit file – Set the project folder and backup file 
• Open an existing project file 
• Keyboard shortcuts 
• Understand the User Interface – Toolbar, Properties, Drawing area, Option bar, and Project Browser 

02 

Create a Site 

• Understand the site plan and information 
• Set the project location and understand building base point 
• Find GIS information 
• Add & Edit Site – Topo surface, roads, side works, property line, building pod, surrounding buildings, and trees 
• Define true north and project north 

07 01 

Set Grids, Levels, Dimensions, & Building columns 

• Import CAD drawings– Floor plans, building elevations, and sections 
• Adjust and verify the scale 
• Create and modify grids and levels 
• Create plan views– Floors and ceilings 
• Create columns with dimensions 

02 
Finalize the (1) site (including terrain, roads, side works, property line, surrounding buildings, and trees) 

Work on building columns 
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08 01 

Add/Edit Beam, Walls, & Curtain Walls 

• Add/Edit Beam 
• Create walls 
• Edit walls wall properties – Wall thickness, Wall details, & Finishes 
• Edit/add wall properties – Wall opening, wall sweep 
• Add/Edit Curtainwalls, Mullions, & Panels 

02 

Understand Visibility settings, Add/Edit Floor & Ceiling, 

• Understand View template, visibility graphics 
• Understand View range 
• Add/Edit Floors  & Floor Properties 
• Add/Edit Ceilings & Ceiling Properties 

09 01 

Add/Edit Stairs, Rails, & Roof 

• Add/Edit Stair – three types of staircases 
• Add/Edit Railing 
• Add/Edit Roof 

02 
Work on building beams, walls, floors, ceilings, stairs, railings, and roofs 

Finalize (2) Floor plans (1st floor & 2nd floor for the House) with dimensions 

10 01 

Add/Edit Windows, Doors, Lighting, Furniture, Tags, & Sheets 

• Understand the concept of family file 
• Add/Edit Doors and Windows 
• Add Tags 
• Add/Edit Lighting fixtures 
• Add/Edit Titleblocks 
• Insert Plan views and symbols – North arrow and graphic scale 

02 

Add/Edit Model-in-Place Components & Edit Family 

• Add/Edit Furniture families 
• Add/Edit Model-in-place components – Custom casework 
• Add/Edit a New Family – Furniture 

Appendix: Ancillaries  |  312



11 01 

Add/Edit Elevation, Section, Detail, Text, Annotation, & Rooms 

• Add/Edit Elevations & Sections – Adjust crop region 
• Add/Edit Detail views 
• Add Texts & Annotations 
• Add/Edit Rooms, Room tags, Room separators 
• Add/Edit a color fill scheme 

02 

Work on furniture, casework, lighting, doors, and windows 

Finalize (2) Ceiling Plans (1st floor & 2nd floor for the House) – design your own lighting layout for the 
House 

Finalize (2) Furniture Plans and Floor Floor Finish Plans(1st floor & 2nd floor for the House) – design your 
own furniture layout and finish choice for the House 

Finalize (2) Elevations (Decide your own views for the House) 

Finalize (2) Sections (House-Section A-A’, House-Section C-C’) – No furniture, Follow the given drawing 

12 01 

Add/Edit Views, Lighting, & Materials 

• Set perspective views 
• Set Isometric views 
• Edit Views – Graphic Display styles 
• Test Render 
• Set sun 
• Edit Artificial lighting 
• Add/Edit materials 
• Render material managements 

02 

Create Revit Rendering, Revit Clouding Rendering 

• Insert other types of files – Sketchup, AutoCAD 
• Advanced render settings 
• Edit render qualities 
• Understand and make cloud renderings 
• Save Rendering outputs 

13 01 

Finalize (2) Perspective views (Revit rendering and Revit Cloud rendering) – (Decide your own views for the 
House) 

Finalize (1) Isometric view (Decide your own views for the House) 

Create a PDF drawing set 

02 

Introduction of Enscape 

• Understand what is Enscape 
• Control/navigate Enscape 
• Create views 
• Add model backgrounds 
• Add Entourages 
• Render images 
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14 01 

Edit Model and Materials 

• Understand workflow, name of the material 
• Use 3D Grass, Water, Reflective, textures 
• Change to Architecture Maquette (White model, Outline) & Light mode 
• Create Orthometric views 

02 

Edit Lighting and Create Video 

• Save, and load presets 
• Set and adjust artificial lightings 
• Create a walk-through video 

15 01 

Edit Render outputs 

• Export enlarged jpg files (Original, ID) for print 
• Create Executable file 
• Create Render Panorama image 

02 

Finalize (3) Perspective views ((2) Enscape rendering + Photoshoped, (1) Lighting analysis) (Decide your own 
views for the House) 

Finalize (1) QR code for Panorama rendering 

Finalize (1) Video (30 seconds) 

Create a PDF drawing set 
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